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Overview
The Pony Voice Preservation Project is a collaborative effort by /mlp/ to create quality AI text to

speech generators for as many My Little Pony: Friendship is Magic characters as possible.

Nine years into the ride and not long before it is scheduled to end, we have reached an age of

technology where a trained neural network can make Trump and Obama recite Steamed Hams,

or make Jordan Peterson perform Lose Yourself using nothing but recordings of their voices.

We have nine seasons, five movies, and a leak’s worth of voice material available to us in high

quality. There is more public research into machine learning than ever before giving us a strong

foundation to build upon. By the end of the year the show will have ended leaving the future of

the community unclear. Now is the perfect time for this project.

The MLP community has always been extremely creative, making an immense amount of fan

content over the span of almost nine years. Having the ability to generate voice lines for a

character without needing their voice actor has incredible implications for fan works, and could

ensure that new content is still made well beyond the end of the show.

This guide will explain how we plan to accomplish our goal, where we are now, and how you —

the person reading this right now — can join in and contribute.

https://www.youtube.com/watch?v=GuJKTodX1FA
https://www.youtube.com/watch?v=HHf1dNHU0os


Current Project Goals
● Refine TacoTron2 Parameters

○ Anons (mainly Cookie and Synthbot) are looking into ways of improving voice quality.

There are many parameters to tune (See HParams). Experimentation is needed to

determine the effects of various tweaks.

○ Can test different parameters yourself (See Training).

○ If you have knowledge of the subject, share it in the thread.

● Encourage archiving

○ If you like what the project has done so far, no better way to back things up than to do it

yourself. Download a copy of the many resources today!

● Encourage use of the tools

○ Much effort has gone into the creation of this, let’s see some results ^:)



How to Contribute

General guide to working independently

This section explains how to contribute INDEPENDENTLY to the Pony Preservation Project.
You can do these things without interacting at all with people already working on the
Preservation Project.

How to contribute to the Pony Preservation Project:

● Anyone with godlike patience - Collect, organize, label, and maintain pony data in
datasets

● AI and data people - Use the data, help fix errors, find good papers
● Anyone artistically motivated - Make original content, ponifications, artisanal shitposts
● Anyone that can keep up with what’s going on - Organize content, make sure people

know how to help, write tutorials
● Developers - Make everyone’s lives easier, make collaboration easier
● Anyone able to reach an audience - Spread the good stuff, and make people love ponies

and AI

This project is driven by the love of ponies and AI, and the contributions of many anons. We can
use all the help we can get. The more people we have working on this, the better our wAIfus will
be!

See the panel to get up-to-speed on the project:

● Slides: Google Docs
● Video: YouTube Mega (stream only) Mega (chat) Mega (chat, low res) PonyTube (Chat)
● Contains an overview of the Pony Preservation Project and information on contributing
● Presented on Jun 13, 2020

Keep up with AI blogs to stay knowledgeable:

● DeepMind’s blog: science & futuristic capabilities possible today
● Google’s AI blog: what will be accessible in a few years
● Facebook’s AI blog: practical suggestions for developers
● Microsoft’s AI research blog: practical research (usually)
● OpenAI’s blog: great new ways of thinking about AI
● Uber’s AI blog: getting AI to handle greater complexity

Learn to use AI developer tools:

https://docs.google.com/presentation/d/1rHNNibckxfCoxZULs7hmaXDKcW7LgcgLYqEG5_ig4Vo/edit?usp=sharing
https://www.youtube.com/watch?v=WtuKBm67YkI&feature=youtu.be&t=261
https://mega.nz/folder/OFZzRQqK#Coi5IEZOnfd8Tc-YYEIiqg
https://mega.nz/file/PVJWFIBR#FPiW-xrEtwDDo9cIp4q-L9KvNgf1NZ1yyOS1v1PM9Jc
https://mega.nz/file/4NARXIDR#jS5UyxFSrSToW2n8HY8X_PpLzmOXYKDcSD99sQWpuus
https://pony.tube/videos/watch/b83fbbfc-6d4e-4768-8deb-edb61ea38abb
https://deepmind.com/blog
https://ai.googleblog.com/
https://ai.facebook.com/blog/
https://www.microsoft.com/en-us/research/blog/category/intelligence/artifical-intelligence/
https://openai.com/blog/
https://eng.uber.com/category/articles/ai/


● PyTorch, Julia, NumPy: These are currently the best frameworks for creating neural
networks. Neural networks are hard to use properly! Follow this >>33987023 wise
anon's guide. (https://desuarchive.org/mlp/thread/33963949/#q33987023)

● scikit-learn, Apache Lucene, Apache MLlib: Tools for creating decision trees and
information retrieval systems.

● C4.5, C5.0, Classification and Regression Trees (CART), Random Forest: Algorithms for
creating decision trees.

● Collaborative filtering, Latent Dirichlet Allocation, TF-IDF: Algorithms for information
retrieval. Read up on TF-IDF before implementing your own!

● SpaCy AllenNLP, HuggingFace, scikit-learn: Tools for natural language (text) processing.
● Kaldi, Parselmouth, librosa: Tools for working with audio files.
● OpenCV, scikit-learn: Tools for working with image files.
● PredictionIO: A tool for creating recommendation engines.

Organize any of this pony data and add it to this doc + post it on the thread:

● Greentext dumps, fanfic dumps, thread dumps, image dumps, show BGM, fan music,
YouTube playlists, comment histories, compilations, "Best of" voting results, blog posts

● Show, community, fanfics, videos, images, games, plushies

Dev & audio anons: figure out what’s wrong with our clips:
Help us figure out what’s going wrong with the clips! We need a better understanding of
precisely what kinds of errors the AI is making when trying to generate voice clips.

1. Get a clean clip of a male voice (since these have the most

problems).

2. Get a waveglow-synthesized version of the same clip.

3. Try out a bunch of standard audio manipulations of the clean

clip.

4. Repeat until we find audio manipulations that sound very close to

the waveglow-synthesized version.

5. Post the final set of audio manipulations.

Colab-capable anons: create ngrok links
Video demo - https://u.smutty.horse/lxlnfvvwoac.mp4

These steps explain how to get an ngrok link to Cookie’s Multispeaker Colab Notebook. This
lets anyone use a Colab server to create audio clips voiced by any of a few hundred characters.

https://desuarchive.org/mlp/thread/33963949/#q33987023
https://desuarchive.org/mlp/thread/33963949/#q33987023
https://u.smutty.horse/lxlnfvvwoac.mp4


You don’t need a fast connection or powerful computer to do this. This uses Google’s resources
to host a server. Ngrok lets you expose Google’s server to the public internet so anyone can
access it.

1. Open Cookie’s scripts in Colab.
a. https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0

?usp=sharing
2. Clip the “Copy to Drive” button. This button is tiny and gray, so it’s hard to see. Ctrl+F for

the text.
3. Follow the instructions in step “1 - Mount Google Drive and add model shortcut”

a. You may need to click the folder icon on the left. You’ll see an option for “Mount
Drive” once you do.

4. Run all of the cells one at a time in sequence until you reach step 3. Once you run the
cell that ends with “!python3 app.py”, you’ll get a link to the server. It will take about a
minute before the link is active.

5. In the same window, open the Dev Tools Console
a. In Chrome, the hotkey to open Dev Tools is Ctrl + Shift + J
b. In the window pane that opens up, select the “Console” tab

6. Copy/paste the following and hit Enter. This will get the Colab instance to stay running
for longer.
function ClickConnect(){

document.querySelector("paper-button#ok").click()
}
setInterval(ClickConnect,60000)

7. Post the link in the thread so other anons can use it.

For a more detailed guide, see the Inference Server guide.

AI anons: test out audio super-resolution with WaveGlow

We’re using WaveGlow to turn Tacotron output (mel spectrograms) into audio samples (PCM).
The publicly-available WaveGlow is trained on 22khz audio, and it sounds good for that
sampling rate. The problem is that 22khz audio doesn’t sound good.

Cookie has tried training a 48khz WaveGlow, but WaveGlow is too difficult to train. One
alternative would be to use the public 22khz WaveGlow model and run the results through an
audio super-resolution network to increase the sampling rate. We need some anon to try this out
to see if it produces good results.

If possible, use a pre-trained audio super-resolution network on WaveGlow’s output directly. If
that produces passable results, post that to the thread because we want to know about that
immediately. Afterward, and if you have time, try to fine-tune the super-resolution network on our

https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0?usp=sharing
https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0?usp=sharing


data. Feel free to post in the thread if you need help using our data. If you don’t have a good
GPU to fine-tune the network, post in the thread and try using Google Colab.

Patient anons: transcribe the dialogue in comics

Comic Anon is trying to extend our transcript dialogue with comic dialogue. The goal is to create
a dataset for a future AI chatbot that can speak like your waifu. In conjunction with speech
recognition software and our Waifu TTS, this would let you chat with your waifu anywhere.

You can see an example comic transcription here:
● https://drive.google.com/file/d/1b2YnpmqSlCKPNBSMDjrFj51-XmZtxFOl/view

Comic Anon has found this OCR tool helpful:
● http://capture2text.sourceforge.net/

Clipper prefers to use speech to text on his phone to dictate the comics aloud.
● Whichever method you use, always double check the output to make sure it’s correct.

Automated methods like these have a tendency to introduce strange errors every now
and then.

Post in the thread to coordinate your efforts with Comic Anon and make sure you’re not doing
redundant work.

Devs in training: learn to do machine learning
An anon recommended this online course:

● https://developers.google.com/machine-learning/crash-course/ml-intro

Post your progress in the thread as well as any questions if you have trouble understanding
anything. We can use you questions to put together a machine learning FAQ.

Musical data anons: create a chord progression dataset
A bunch of anons are creating singing pony clips. Putting a simple chord progression on top of
the clips seems to add a lot to the clips. If we had a dataset of chord progressions played at
many tempos, in many styles, with many different instruments, anons could just copy/paste a
chord progression over a clip with a little searching.

We don’t know how to create such a dataset. If you do, post your ideas in the thread.

https://drive.google.com/file/d/1b2YnpmqSlCKPNBSMDjrFj51-XmZtxFOl/view
http://capture2text.sourceforge.net/
https://developers.google.com/machine-learning/crash-course/ml-intro


Web dev anons: create a *booru for audio data

Clipper has created a dataset of sound effects and background music with his own tags. The
intention is to have a searchable repository for sounds that anons can add to their generated
clips. The additional background music and sound effects add a lot more depth to the clips.

Derpibooru’s tagging system is very good for getting high-quality, searchable tags for images
and animation clips. It would be nice if we could have a *booru for audio clips with a similar
tagging system.

Note that Danbooru has source code available.
● https://github.com/danbooru/danbooru

If you decide to work on this, please post in the thread.

Patient anons: check phoneme pronunciations

Phoneme pronunciations are good for a number of things.
● We can use it with a phoneme alignment tool to get information about how the speaking

rate varies throughout a clip. This gives us speed information that we can feed to our AI
models.

● It helps catch transcription errors, like spelling errors or text normalization issues.

We have pronunciations for most of our pony data, thanks in large part to Pronunciation Anon.
In some cases and for newer data, we used auto-generated pronunciations. Most, if not all, of
our pronunciations were written based on existing dictionary entries without any listening tests.
We need to verify our pronunciations to make sure they line up with how ponies actually say
these words.

You can find our list of missing words, filled-in pronunciations, and corresponding audio samples
here:

● Auto-generated pronunciations only:
https://drive.google.com/file/d/1LpPWxUXQ0rrW_GgTdq-77gnTV0CJN30s/view?usp=sh
aring

● Auto-generated & manually-entered pronunciations:
https://drive.google.com/file/d/17v7T9aANMAjtroFxLbIyxqwJImkhX1m7/view?usp=sharin
g

https://github.com/danbooru/danbooru
https://drive.google.com/file/d/1LpPWxUXQ0rrW_GgTdq-77gnTV0CJN30s/view?usp=sharing
https://drive.google.com/file/d/1LpPWxUXQ0rrW_GgTdq-77gnTV0CJN30s/view?usp=sharing
https://drive.google.com/file/d/17v7T9aANMAjtroFxLbIyxqwJImkhX1m7/view?usp=sharing
https://drive.google.com/file/d/17v7T9aANMAjtroFxLbIyxqwJImkhX1m7/view?usp=sharing


For each of these, you would need to enter the provided pronunciation into ngrok, or any other
TTS tool that accepts Arpabet, and listen to the result to make sure the pronunciation lines up
with the show audio. Please report any errors in the thread.

Note that we do NOT want to include typos in our pronunciation dictionaries. If you see a typo,
please report it in the thread so we can fix it in our dataset. If a word has a stutter, please make
sure the phoneme pronunciation reflects the stutter. For example, “I-I-I’M” should have the
pronunciation “AY0 AY0 AY1 M” (which becomes {AY0}-{AY0}-{AY1 M} in ngrok) to reflect the
fact that the “I” is repeated when spoken.

Anons motivated by the prospect of animation AI
Take a look at our Animation AI section. Ask questions, post suggestions, and help out
wherever you can.

Animation Anon is working on tools to load available Flash assets. Clipper is going through
Derpibooru tags to find ones that would be useful as animation commands. Synthbot is doing
whatever task isn’t claimed. This is a difficult task and it requires a lot of work, but it seems to be
possible for at least some characters.

We need to do a lot of work to get to the point where we can apply animation research to
ponies. We just need to get to that point so we’re basically guaranteed to get animation AI as
researchers continue making progress.

Suggest Sources for Text Data

To make a text generator AI, we need good sources of pony text data. This would primarily
consist of transcripts of episodes, Equestria lore from various wiki pages, and generic slice of
life type fanfics. Once we have a good pile of text data to work with, we can refine it down to
discard any elements we don’t want. Since this will start as a baseline model, the most useful
elements would be descriptions of the facts of Equestria and natural interactions of the main
characters.

Below is a list of suggested sources. If you have any other ideas to suggest, please put them in
the thread. Note that just because a link is suggested here, does not necessarily mean that all
of it will be used. Each source will need at least some manual vetting to remove unnecessary or
undesirable elements.

MLP fandom wiki



Episode transcripts - https://mlp.fandom.com/wiki/Special:BlankPage?blankspecial=transcripts

https://u.smutty.horse/mbsoykdnonq.7z

Characters - https://mlp.fandom.com/wiki/Characters

Locations & Settings - https://mlp.fandom.com/wiki/My_Little_Pony_Friendship_is_Magic

Lore - https://mlp.fandom.com/wiki/Category:Society

Misc - https://mlp.fandom.com/wiki/Cutie_marks

https://mlp.fandom.com/wiki/Friendship_lessons

Wikipedia

https://en.wikipedia.org/wiki/Equestria

https://en.wikipedia.org/wiki/List_of_My_Little_Pony:_Friendship_Is_Magic_characters

TVTropes

https://tvtropes.org/pmwiki/pmwiki.php/Analysis/MyLittlePonyFriendshipIsMagic

https://tvtropes.org/pmwiki/pmwiki.php/JustForFun/Equestria

https://tvtropes.org/pmwiki/pmwiki.php/Recap/MyLittlePonyFriendshipIsMagic

https://tvtropes.org/pmwiki/pmwiki.php/Characters/MyLittlePonyFriendshipIsMagic

Fimfiction

In regards to fanfics, we'll obviously want to keep it as FiM related as possible and keep
extreme and niche settings/fetishes etc to a minimum (at least for a "base model"), so the "Slice
of Life" Fimfic group is probably the best place to start since that should have fairly generic
settings and more emphasis on everyday character interactions. Suggest taking the top hundred
or so rated fics from the "Main", "Normal" and "Comedy" segments (watch out for duplicates) of
the Slice of Life group for a first pass. Once we have that we can just discard any stories with
tags we don't want and refine it further from there.

https://www.fimfiction.net/group/225/folder/11206/main?order=rating
https://www.fimfiction.net/group/225/folder/896/normal?order=rating
https://www.fimfiction.net/group/225/folder/894/comedy?order=rating

The G4 story bible

We only have this image version for now, which could be converted to text with some effort

though a plain text version would obviously be more helpful here.

https://u.smutty.horse/mbvvgxeqmoi.7z

https://mlp.fandom.com/wiki/Special:BlankPage?blankspecial=transcripts
https://u.smutty.horse/mbsoykdnonq.7z
https://mlp.fandom.com/wiki/Characters
https://mlp.fandom.com/wiki/My_Little_Pony_Friendship_is_Magic
https://mlp.fandom.com/wiki/Category:Society
https://mlp.fandom.com/wiki/Cutie_marks
https://mlp.fandom.com/wiki/Friendship_lessons
https://en.wikipedia.org/wiki/Equestria
https://en.wikipedia.org/wiki/List_of_My_Little_Pony:_Friendship_Is_Magic_characters
https://tvtropes.org/pmwiki/pmwiki.php/Analysis/MyLittlePonyFriendshipIsMagic
https://tvtropes.org/pmwiki/pmwiki.php/JustForFun/Equestria
https://tvtropes.org/pmwiki/pmwiki.php/Recap/MyLittlePonyFriendshipIsMagic
https://tvtropes.org/pmwiki/pmwiki.php/Characters/MyLittlePonyFriendshipIsMagic
https://www.fimfiction.net/group/225/folder/11206/main?order=rating
https://www.fimfiction.net/group/225/folder/896/normal?order=rating
https://www.fimfiction.net/group/225/folder/894/comedy?order=rating
https://u.smutty.horse/mbvvgxeqmoi.7z


Original show bible PDF:

https://u.smutty.horse/lvocxbhiftu.pdf

https://u.smutty.horse/lvocxbhiftu.pdf


Voice

What can I do with the AI?

The various AI voice generation tools that have been created by this project are incredibly
versatile and have many potential applications. If you’re looking for something fun to do with the
voices but are currently lacking inspiration, here’s a list of ideas:

Skits
- These are essentially verbal oneshot greentext stories, generally short comedic

performances where the silly ponies say silly things. Examples include various works by
Snoopy Anon, BGM, Clipper and other anons. Here are some animated examples.

- If you’re an absolute madlad, you could try re-dubbing a whole episode or a Peanuts
Christmas special.

- See Clipper’s Master file 2 for a folder containing various sound effects and background
music that can be used to enhance your creations.

Some skit suggestions:
- Trixie writes a book she wrote about herself and her life called “The Hardships of Being

Unequivocally Superior”.
- Your pony of choice lists off the undesirable traits of other ponies to woo Anon by

showing that they are logically the superior mate.
- Trixie gets sick of bills and tries to get Twilight to marry her for the sweet princess

money.
- AJ speculates about starting a family with you.
- Ponies swooning over Anon, listing off traits like gamer, lives in a basement, watches

anime, doesn’t bathe, is overweight etc. like they’re traits of an ideal man.
- Anon is being chased by an angry Dash, could be interesting to play with 360 audio

positioning.
- Twilight builds a robotic assistant modeled on herself to help with problem solving, but

robo-twi inherits her neuroticism, which feeds mutual freakouts.

Comics
- If you want to do a skit, but are finding it hard to write original material, you can try

dubbing a comic instead. Grab a comic from one of the boorus, run the lines through the
AI, add sound effects and music if you want, and then use a video editor like Shortcut to
piece it all together.

- The Pony Hackers is a good example of this.

https://u.smutty.horse/lveoofuvytt.mp3
https://u.smutty.horse/lvtxvknpzeh.wav
https://u.smutty.horse/lybxxbvphoc.wav
https://u.smutty.horse/lvxmnhpznil.mp3
https://u.smutty.horse/lwfswlnxaoy.mp3
https://u.smutty.horse/luvgljjuiqh.mp4
https://u.smutty.horse/lwfswzjuiiy.mp4
https://drive.google.com/file/d/1Qb6zMbbJm8dcEX_h9BL0-Rdwz_Ir3YDW/view?usp=sharing
https://drive.google.com/file/d/1XLylzV16kAYiEp8LaeoLUhqVqleUl2a8/view?usp=sharing
https://drive.google.com/file/d/1XLylzV16kAYiEp8LaeoLUhqVqleUl2a8/view?usp=sharing
https://mega.nz/folder/0UhSmYAB#WBrB-qCprQTofkAhwMp5CQ
https://shotcut.org/
https://u.smutty.horse/lurlvkebijx.mp4


Voiced fanfics/greentext
- If you want to go for something bigger than comics, there is a near infinite selection of

classic greentext stories and fanfics that would be wonderful to listen to as audiobooks.
- These are generally a larger commitment, but are also easy to produce since

everything’s already transcribed for you. All you need to do is feed it into the AI and edit
it together in Audacity or similar. The level of complexity with these projects is usually
defined by how autistic you are about finding the best sound effects and music.

- Clipper’s dub of Insults Are Magic is a good example of what’s possible with AI voices
combined with sound effects and background music.

- While you’re at it, you could also label the story with Synthbot’s fanfic labeller to help
improve the fanfic dataset.

Singing/rap/poetry
- Previous attempts at “singing” were mostly just anons trying to force the AI to speak lines

in time with a beat, but with the recent addition of SortAnon’s TalkNet, we can now
create singing and rapping lines based on reference clips fed to the AI as well as the
input text.

- Here are some examples of what anons have made with this new capability.
WoodenToaster - Rainbow Factory (BGM Remix) (ft. TalkNet)

Professions of love
- Self explanatory. Do it for her.
- Here for you, Twilight’s voicemail

Suggested workflows:
These propositions may be equally daunting as they are inspiring, and it may be difficult to work
out where to start. Here are some example workflows written by those who’ve created various
AI voice projects in the past to help you get started.

- Clipper, Insults Are Magic.
- Find original greentext in desuarchive, and from there find a screencap and

pastebin.
- (Optional) Label text from pastebin with Synthbot’s fanfic labeller.
- Crop screencap into smaller manageable pieces that would easily fit on a typical

screen.
- Generate lines using the various voice generation tools available, usually three

times per line to give multiple options. Lines are typically organised by character
and named 1a, 1b, 1c, 2a, 2b, 2c, 3a etc. The numbers refer to the spoken lines
in chronological order and a, b and c are the duplicates of each line that were
generated to allow for multiple options per line.

https://mega.nz/file/pBp3BQKA#6aa0OV1S2wEdqT5l9PE1Ett99deQECf2jroxJ8-BvSA
https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit#heading=h.r6i73362axyo
https://colab.research.google.com/drive/1aj6Jk8cpRw7SsN3JSYCv57CrR6s0gYPB
https://u.smutty.horse/mccpdvywsdw.mp3
https://u.smutty.horse/mcixvofmfxh.mp3
https://u.smutty.horse/mbqacswulum.ogg
https://u.smutty.horse/mbqddkmktnx.wav
https://youtu.be/BBSUc6aT-IA
https://youtu.be/psS0fTknd-c
https://youtu.be/BBSUc6aT-IA
https://u.smutty.horse/luipsdwpgkt.mp3
https://u.smutty.horse/lwftvghjkep.wav
https://mega.nz/file/pBp3BQKA#6aa0OV1S2wEdqT5l9PE1Ett99deQECf2jroxJ8-BvSA
https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit#heading=h.r6i73362axyo


- (Optional) Record voiceover for narration and lines spoken by Anon. I chose to
use my own voice, but you could use another AI if you prefer.

- Go through each line and pick the best variant for each one, can also combine
elements of multiple takes if some options perform better in some areas but
worse in others.

- Arrange refined lines in chronological order in Audacity, no particular attention
paid to timing at this stage.

- (Optional) Add sound effects and background music. I used a separate audio
track for dialogue, music and sfx, and also a few extra tracks for when I wanted
to layer multiple sound effects at once.

- Adjust the timing of each line and sound effect, also re-generate any lines if
needed.

- Export finished audio file, and import into chosen video editor.
- Rig up a simple slideshow with the screencap of the greentext, and add end

credits.
- (Optional) Edit the credits.
- Export video file and upload.

- Anon, Pony Hackers and various other comics
- Sample projects (Mega)
- Find a suitable comic

- If you already have a comic in mind, then you’re already good to go.
- You’ll probably want to take into account the amount of time it will take to

complete a comic, make sure it’s not going to take more time than you’re
willing to give it.

- Comics with more pages will obviously take more time, but also take into
account the amount of text per page/panel.

- Dialog with a lot of emotion and/or non-standard pronunciation will take
more time to fine tune.

- Look to see what characters are featured in the comic and that suitable
models are available for them. For background ponies/OCs, try to have a
plan ahead of time. Like applying sound effects to another character’s
voice.

- If you want to do a video, look at the formatting and consider how you’d
want to present it. Speech bubbles are probably easiest to deal with.

- Extract lines from comic
- Go through the comic and type out every speech segment into a new line

on a text editor.
- It can also be helpful to make notes on emotion, pronunciation, or other

aspects of line deliveries.
- Try to include enough information so that you don’t have to reference

back to the comic. In the middle of generating lines it can be easy to
forget little details.

https://mega.nz/folder/zUgS2CBL#I_IkqRBl2-wYXJWNeXIlzw


- Generate lines
- Have a plan in place for file organization. My organization is typically

p[panel].[line].wav with each page having it’s own folder. For example,
under this scheme page 1 panel 3 line 5 would look like: “page
1\p3.5.wav”.

- Reference “Making the Most of the AI” section for tips on improving your
lines.

- Context at the beginning of a line will have a greater effect on the delivery
than context that comes after. I typically use context at the beginning for
big adjustments and context after for fine tuning.

- Punctuation has an effect and can sometimes result in strange things. For
example, for a shouting line it may work better using context and a period
instead of an exclamation mark.

- If you want to keep the tone of the character constant, using the same
context in front of various lines will go a long way to help with this.

- Generate several versions of the same input and select which one sounds
best. If it isn’t exactly what you want, mess around with different inputs to
see what other results can be achieved.

- Assembling lines
- Decide whether you want to assemble audio in an audio editor or in a

video editor. If you intend on making a video out of the comic later,
assembling the lines directly in the video editor will give you more
flexibility later. I will say that assembling the audio in a dedicated audio
editor (like Audacity) first is a bit easier.

- I’d recommend first assembling the lines on their own and focus on trying
to get things sounding natural.

- Consider where you’ll apply sound effects later and give some breaks in
the audio where these will happen. Don’t worry too much about the
duration of breaks at this point, mainly use them as a marker for later
when applying sound effects.

- Use separate tracks for different characters. This makes it easy to keep
track of which audio belongs to who.

- You can also consider panning the audio tracks to give an effect like
characters being in different locations.

- Finding sound effects and background noise
- The YouTube audio library is a good resource for professional sound

effects and music. All you need is a Google account to access. Take note
if you need to credit anyone when you use audio from here.

- Most of my background audio comes from sound effects uploaded on
YouTube itself. Note that this will not result in the highest quality of audio,
but this is honestly the best way to find what you're looking for.

- Keep background noise and music on a separate track from sound
effects.



- Most sound editors have the ability to generate different types of noise.
For example, Audacity can generate white, pink, and brownian noise. This
can help make it seem like audio was recorded on an actual microphone.
Just keep it subtle if you do use it.

- Creating video
- I usually use an image editor to prepare all of my frames ahead of time

before starting in a video editor.
- For each panel you’ll want to crop the image down to just the panel itself

(if applicable).
- Make a second layer on top of the panel and use a brush tool to paint

over the dialog. You can then erase from the second layer bit by bit to
reveal the speech as needed. Save an image for each line. Be sure to
include a blank with no dialog as it can help make video transitions easier.

- I would recommend using a similar naming scheme to the audio files.
Whatever you do use, make sure that everything works out to be in
alphanumerical order so when you go to import into the video editor
everything is in order.

- Make sure to save your project files for each panel, typically just the panel
with the fully blanked second layer. This makes it easier if you need to go
back and make any changes.

- Once you’ve finished making your frames, import all the audio and
images into your video editor.

- If your video editor supports showing the audio levels on the timeline, you
can use this to help position when the frames appear. I usually make the
next frame appear slightly before the character says the line.

- For video transitions I usually keep it simple. Each frame, the video just
cuts to the next frame. I generally use a fade between panels and a dip to
black between pages. This is just personal preference and only really
suitable to comics that are structured as panels.

- Tips on posting
- For posting on 4chan, smutty.horse is a personal favorite of mine to use

as host.
- Formatting as webm makes it a lot easier to upload to various places.
- This is a simple tool to make webms. Be sure to check “Enable Audio” at

the bottom. Note that this tool is designed to produce webms for 4chan
and will target a 4mb file size. Encode options are limited.

- As of late i’ve been using ffmpeg directly to try and get the most out of a
limited file size. I was targeting a file size under 25mb. The following is the
options/command I use. Some notes: vp9 is the video codec used, opus
is the audio codec used, audio is limited to 16 bit, audio bitrate is 120k,
video is set to use a CRF of 35, video will be converted to 30Hz, video is
scaled to 720p, threads is set to 16 (set this to the number of threads your
CPU has, 16 is just what I have).

https://github.com/WebMBro/WebMConverter


ffmpeg -i input.mp4 -c:v libvpx-vp9 -c:a libopus -sample_fmt s16 -b:a 120k -vbr on -crf 35 -b:v 0
-vsync 2 -r 30 -vf scale=1280:720 -thread 16 output.webm



Tutorials

Creating an audio dataset

This is a guide on how to create a dataset of raw voice clips and text transcripts for any given
source of audio. The output of this process can then be used to create a dataset for training in
Google Colab and/or submitted to 15 (fifteenai15@gmail.com) for potential use at
https://fifteen.ai/

Note that our system uses a file naming system different to that specified for contributions on
15.ai, however 15 is able to use the pony dataset without issue so it should be fine to submit
your datasets to him using the same format we do. Just make sure you follow the format closely
and note in your submission that you used the same system as us. Alternatively, you could
adapt the PPP method to use a different naming system if you prefer. Please also share any
datasets you create in the thread, more data is always helpful.

Before you start any work, please post in the current PPP thread about what you plan to do so
other Anons know what’s being worked on.

See also the section on cleaning audio if your audio source contains undesirable elements such
as sound effects that obstruct the voice.

To submit your contributions, please follow the guidelines for submitting your content when you
are done.

See also the “Automatic Clipping and Transcribing” section for an alternate method.

If you have any questions about the process, ask Clipper in the thread.

Overview

The full process is demonstrated by Clipper in this YouTube video.

The goal of this process is to take the full cut of an audio source and slice it into its individual
lines, which will all be tagged with data such as the character speaking, the emotion with which
the line is spoken and a full transcript of all the words spoken in each line.

https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit#heading=h.wyltjtimrkhb
https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit#heading=h.wyltjtimrkhb
mailto:fifteenai15@gmail.com
https://fifteen.ai/
https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit#heading=h.z3h8i1lam648
https://www.youtube.com/watch?v=Bsu7mwa-QGY


Here is an overview of the core steps of the dataset creation process:

1. Obtain audio for your chosen character
2. Obtain subtitle .srt file and transcript, if possible.
3. Download Audacity, Notepad++, and Python.
4. Use the subtitle to Audacity app, if you were able to get a subtitle file.
5. Run the character tagger program, if you were able to get a compatible transcript.
6. Import the audio files into Audacity, and then create and edit labels as needed.
7. Export labels from Audacity and run them through the checking script, correcting any

errors it finds.
8. Re-import the corrected labels into Audacity and export the audio clips.
9. Create a text transcript of all the newly created audio clips.
10. Upload all the files you’ve created.

We will now explain the process of each of these steps in more detail.

Obtaining Audio
There are several potential sources of audio, and some sources will be better than others. Here
are some suggested sources, in order of most ideal to least ideal:

- Raw studio recordings
- PC game files
- Audiobooks and podcasts
- Netflix and iTunes videos
- YouTube videos

Raw studio recordings are often the hardest to obtain but will offer perfectly clean studio quality
voices which are the best source of any audio. We were lucky enough to get some studio
recordings for various MLP episodes from BigHckintosh as part of the Hasbro studio leaks.

The sound files in PC game files are often similar in quality to raw studio recordings and are
easier to obtain. If you’re training for a character or voice actor that appears in a video game, go
digging through the files and see what you can find. You can also consult forums dedicated to
the particular game if finding the specific files proves difficult.

Audiobooks and podcasts are also usually recorded in proper sound studios, but will also tend
to have undesirable elements such as music and sound effects mixed in. These are often easily
accessible on their respective host websites, and you can even download podcasts directly from
iTunes.

Shows hosted on Netflix and iTunes are usually in high quality, but will almost certainly contain
sound effects and background music which will obstruct the voices. This can be mitigated to an



extent, but it’s never going to be as good as the raw recordings. For iTunes, you can simply
download videos directly. To download videos from Netflix, you will need to use Flixgrab. For
both Netflix and iTunes, make sure that the video you download has 5.1 audio, a format which
should allow you to isolate and remove background music. You can usually find audio
information like this in the detailed video descriptions. Note that obtaining 5.1 rips of audio in
multiple languages will also be useful for removing background noise.

A YouTube video can be used if there is no material available on Netflix or iTunes, but is a much
less ideal source as compression will compromise audio quality. The audio will also only be
available in stereo, which means you won’t be able to remove any music. Only use YouTube if
there is literally no other viable option. Search for “youtube downloader” in Google for various
online solutions to directly download videos from YouTube.

As a general rule, you should aim to obtain at least thirty minutes of audio for your chosen
character before attempting training. This is the minimum amount of data you need to guarantee
a reasonable chance of getting a decent output from your model. As with all applications of
artificial intelligence, more good quality data will result in a more accurate model, so you should
always aim to gather as much data for your chosen character as you can.

Obtaining Subtitles and Transcripts
Subtitles contain information on the content of speech and the time it occurs, which we can use
to create Audacity labels to give us a head start. It may be possible to rip these files from a
Blu-Ray disk, or they may be found online here. You can also use this programme to download
subtitles from YouTube videos, make sure you download in .srt format.

We have also created a tool to automatically tag characters to their lines with the help of a
transcript. For this tool to work, you will need a transcript in the same format as shown here. You
may be able to find a transcript like this for your show at https://www.fandom.com/. Even if you
can’t find a transcript in this exact format, it can still be used as a source to copy-paste from to
help with transcribing lines later on.

If you can’t find .srt files and/or a transcript for your audio, don’t worry too much. This step is
optional, though having these files will make your life much easier later on so it is strongly
recommended to make every reasonable effort to find them.

Acquiring Software
Audacity is a free open-source audio editor, we will use it to do the work of slicing the audio into
its individual lines. Download Audacity here.

https://www.flixgrab.com/
https://www.addic7ed.com/
https://www.dvdvideosoft.com/free-youtube-subtitles-download
https://mlp.fandom.com/wiki/Transcripts/Friendship_is_Magic,_part_1
https://www.fandom.com/
https://www.audacityteam.org/


Notepad++ is an enhanced version of notepad for editing text files. We will demonstrate some of
its useful features later. Download Notepad++ here.

Python will allow us to run scripts to automate some steps for editing Audacity labels later. Don’t
worry if you don’t have any expertise in coding, we won’t be doing anything complicated and all
the steps are fully demonstrated in the video. Download Python here.

Simply download and install these in the same way you would for any other programme.

If you are using a Netflix/iTunes/YouTube video as your audio source, you will need to isolate
the audio from the video. The easiest way to do this is to install the FFMPeg plugin for Audacity,
which will allow you to import video files just like you would for an audio file. Instructions for the
Audacity plugin can be found here.

Subtitle to Audacity Tool
If you weren’t able to get a subtitle .srt file, you can skip this step and also the Character Tagger
step. Click here to skip this section.

Open the .srt to Audacity app here.

This is the subtitle to Audacity converter. It will generate Audacity labels with the information in
the subtitle file, which will give us a head start. To use it, simply open the subtitle file in the app,

https://notepad-plus-plus.org/downloads/
https://www.python.org/
https://manual.audacityteam.org/man/installing_ffmpeg_for_windows.html
https://www.construct.net/en/free-online-games/srt-audacity-5165/play


then click merge overlapping labels. This will merge any subtitles with overlapping timestamps
into a single label. I recommend you leave the other two options blank. We will automatically
generate timestamps later, and the safe filename option will remove question marks, which you
will have to retype later.

The drop-down option will allow you to choose a formatting option for the output. You can use
whichever formatting you want. Run the app, and save the output in a useful place.

If you were able to find a suitable transcript for your audio for use with the character tagger, go
to the next section now. If not, keep reading.

Open the output of the subtitle to Audacity app in Notepad++ and use a macro to add three
underscores to the start of every label. The use of macros in Notepad++ is demonstrated in the
video here. Once done, follow this demonstration in the video to make some minor edits to the
labels before importing them into Audacity.

Character Tagger
If you weren’t able to get a transcript in the format shown earlier, you can skip this step. Click
here to skip this section.

This is the Character Tagger. It will attempt to match every spoken line to a character by
comparing the lines to a transcript. Open the output from the subtitle to audacity app from the

https://youtu.be/Bsu7mwa-QGY?t=485
https://youtu.be/Bsu7mwa-QGY?t=485
https://youtu.be/Bsu7mwa-QGY?t=522


previous step in the middle box, and then copy and paste the transcript in the left box. In the
suffix box, type in three underscores, and then click label unknown characters. Exactly why we
do this will become clear in the next step. Run the programme and save the output in a useful
place.

Open the output of the Character Tagger in Notepad++ and follow this demonstration in the
video to make some minor edits to the labels before importing them into Audacity.

Clipping Audio in Audacity
This process is demonstrated in full in the video. I suggest you use the video as your primary
source of information here as I feel that a live demo explains the process better than can be
done with simple text and screenshots.

Open the dialogue audio file in Audacity. Once the audio has finished loading select
“File” ->” Import” -> ”Labels” in the menu. Choose the label file that we just created in the
previous step. If you skipped the subtitle to Audacity step, you won’t have any labels to import
and will instead need to create them manually. Create a label track by selecting “Tracks” -> “Add
new” -> “Label Track”. See this section of the demo video for a guide on creating labels
manually.

https://youtu.be/Bsu7mwa-QGY?t=522
https://youtu.be/Bsu7mwa-QGY?t=522
https://youtu.be/Bsu7mwa-QGY?t=621
https://youtu.be/Bsu7mwa-QGY?t=1145


The idea here is to draw labels around all the individual lines of dialogue, and then fill those
labels with the information we need. The start and end points of each label will mark the start
and end point of each clip. The black vertical bars in the label track represent label boundaries,
beginning and end. Clicking and dragging on either will allow you to start a selection from that
point. The circular buttons on either end of the label text allow you to move the entire label in
time, and the triangles attached to the circles allow you to move the beginning or end
individually. You can create new labels if needed by highlighting a section of audio and pressing
“Ctrl+B”.

Use this to create and adjust labels as needed. You may combine labels as needed if the audio
doesn’t split well on the existing bounds between two labels, though there’s no automatic way of
doing this. Simply right click on and delete the second label and extend the first one to
compensate.

Audio clips should contain about a sentence worth of dialogue, but it is most important that your
clips are split in a way that sounds natural. Do not let clips start part way into a word or let them
end in the middle of one. Try to clip such that the emotion conveyed by the tone of voice is
consistent throughout. Audio clips should also contain entirely noisy or entirely clean audio, so
take this into account as well when deciding where to put your clip boundaries. When filling in



the labels, you must make sure to include all the necessary information in the format shown
below:





Timestamp - Ignore the timestamp while filling in the labels in Audacity, we will automatically
generate it later.

Character - You can use abbreviations for tagging characters while clipping your audio to save
time, for example “twi” for “Twilight”. You can use whatever abbreviations you want, just make
sure you keep a note of what you have used for future reference, you will need to enter the
abbreviations you’ve used into the checking script in the next section.

Emotion - The suggested list to use is: Neutral (n), Happy (h), Amused (am), Sad (s), Annoyed
(a), Angry (ag), Disgust (d), Sarcastic (sa), Smug (sm), Fear (f), Anxious (ax), Confused (c),
Surprised (su), Tired (t), Whispering (w), Shouting (sh), Whining (wh) and Crazy (cr). It is
suggested to use the one or two letter abbreviations given in the brackets for quicker and easier
tagging, these abbreviations will be expanded into their full versions with the use of the checking
script in the next section. If appropriate, you can use multiple emotion tags in a clip, such as
“Happy Shouting” or “Angry Whispering”. In these cases, make sure that the tags are separated
by a space. You can also invent and use other emotion tags if you feel that none of the emotions
listed above fit your audio. If you do this, make sure to keep a note of what you have used for
future reference, you will also need to enter the abbreviations you’ve used into the checking
script in the next section.

Noise - This is a difficult concept to explain as it’s always going to come down to a judgement
call. It is important to get this right, so make sure you put on a decent pair of headphones and
listen carefully. If a clip is clean, that is free from all but the most trivial of noise, then leave the
noise tag blank. Make sure that the underscores are still included. If there is significant noise in
a clip, then you will need to make a judgement call. Marking it as noisy is effectively you saying
that you would be happy to use that clip for training, despite the small amount of noise it still
has. Marking the clip as very noisy is effectively you saying that the clip is unsuitable for training
due to excessive noise. Generally speaking, for a clip to qualify as noisy, you should be able to
clearly make out all syllables of every spoken word, and the noise itself should be quieter than
the speech. It’s usually best to be strict for the sake of preserving quality, so If you find yourself
in doubt between clean and noisy, tag it as noisy. Similarly, if you find yourself in doubt between
noisy and very noisy, tag it as very noisy. Use the shorthand “q” for noisy and “qq” for very noisy.

Dialogue - The transcript must contain every word that is spoken in each clip, exactly as
spoken, with correct spelling and punctuation. Remember that all pauses should be represented
by a comma or full stop, whichever fits best. All sentences should end with either a full stop, a
question mark, or an exclamation mark. A sentence should not end with a comma. Also be
careful not to make the clip too long, as everything you enter into the label will later become the
filename for that clip. Windows imposes a hard cap of 260 characters for a filename, including
the directory. As a general rule, each label should contain about one sentence of speech. The
length should be at least one second, and no more than ten seconds. You can combine and split
labels however you feel is best.



Keep in mind to not make the label of the clips too long, as what you enter into the label will
later become the filename of that clip. Unfortunately Windows, being a shit OS, has a hard file
name limit of 260 characters. Note that the character limit includes the file directory, so if you
find that a filename has become too long to edit, try moving it out of folders/subfolders and into
just the “Documents” section in the file explorer. This will shorten the directory path and allow
you to edit filenames that would otherwise exceed the character limit.

Example:
C:\Users\Anon\Documents\PVPP\Sliced
Dialogue\FiM\S1\s1e1\00_00_05_Celestia_Neutral__Once upon a time, in the magical land of
Equestria..flac (135 characters)

C:\Users\Anon\Documents\00_00_05_Celestia_Neutral__Once upon a time, in the magical land
of Equestria..flac (102 characters)

After editing the filename, you can then move it back into the original folder/subfolder, even if it
exceeds the character limit.

I’ll recommend again that you watch the section in the demo video that covers this section, as a
live demo will communicate the process better.

Checking Script
We have now made the labels in Audacity with the character, emotion and noise tags and
transcript. The next step is to make sure that there are no mistakes and add the timestamp to
the start of each label. Refer back to the file naming system for details on the format of the
timestamp.

Before following any of the instructions below, make sure you have exported the Audacity
labels. File -> Export -> Export labels. Name the file “labelsraw.txt”.

The checking script is available here. It will do the following:

- Replace shorthand character, emotion and noise tags with their full versions.
- Add a timestamp to the start of each label in the correct format.
- Check for some common abbreviations in the dialogue that should be expanded into

their full versions, such as Mr. for mister.
- Check for any numbers in the dialogue that should be replaced with the word version.
- Adds a full stop to the end of any label that does not end with any sort of punctuation.

https://youtu.be/Bsu7mwa-QGY?t=621
https://pastebin.com/2B2skWsv


I will write out the full process for using the script, but I highly recommend watching the
demonstration in the video. I feel it does a much better job of explaining than can be done with
just text and screenshots.

To use the script, copy and paste it into a new Notepad++ file, and save it with a .py extension.
This will save it as a Python executable. You can name the script whatever you want, the
extension is the only thing that matters here. Create a new folder for the script and save it there,
making sure there is nothing else in that folder.

From lines 158 to 398, you can see the stored information for shorthand character codes. You
can add, remove and change any entries as needed, just make sure it’s all in the same format
as seen in the script, this is demonstrated in the video. The script will check for any
abbreviations in the character field, and replace any it finds with its corresponding full version. It
can also check for longer character tags and replace them with a shortened version.

From lines 400 to 423, you will see the entries for emotion. From lines 425 and 428, you will see
the entries for noise. From lines 430 to 433, you will see the entries for abbreviations. These all
work in the exact same way as for the characters, and you can also add to and edit these
however you like, just make sure the formatting is kept consistent.

We now need to do just one more thing before we’re ready to run the script. We need to tell the
system to run the script in the console window so we can see its output as it goes through the
labels. Create a new file in notepad++, and type the following:

@echo off
python filename.py
pause

Replace “filename” with whatever you named the checking script. Save this file as “Run.bat” in
the same folder as the checking script. This process is also demonstrated in the video.

We are now ready to run the checking script. Copy the Audacity label file into the folder
containing the checking script, and name it “labelsraw.txt”. Double click run.

You will see in the output “labels.txt” folder that the script has added all the timestamps to the
start of each label, and expanded all shorthand tags to their full versions. The demo video
contains examples of how the checking script alerts you to any errors.

Once you have fixed all the errors the script has found, run it again on the corrected
labelsraw.txt file to make sure nothing was missed. Once done, you can discard the
labelsraw.txt file. We now need to do one last check on the output label file. Use find and
replace to correct any cases of double spacing, and make sure there are no spaces before or
after any of the underscores. Then copy and paste the labels into a word processor, such as

https://youtu.be/Bsu7mwa-QGY?t=1363
https://youtu.be/Bsu7mwa-QGY?t=1363
https://youtu.be/Bsu7mwa-QGY?t=1489


Microsoft Word or a Google document and run a spell-check. Fix any spelling errors it finds and
copy the corrected labels back into the Notepad++ file. Save the file containing the completed
labels.

Exporting Audio Clips
Import the new labels into your Audacity project and delete the old ones. We are now ready to
export the audio to make the individual clips. It is recommended to disable “Show Metadata
Tags editor before export” in the “Edit” -> “Preferences” -> “Import/Export” menu to prevent a
window popping up for every single label in your project.

Now go to “Export -> Export Multiple”. Make sure the settings match what you see in the
screenshot below, and then select the folder you want to export the clips to. Once done, click
export.



Question marks are not allowed in filenames, so Audacity will automatically ask you if you want
to change them to an underscore. Press the enter key to confirm the change, along with every
other label this applies to. Do not spam or hold down the enter key, as this occasionally creates
duplicate files.

You may run into an error while exporting that interrupts the process. The most common cause
of this is that the filename is too long, remember the 260 character limit for a filename, including
the directory. If this happens, simply go to the label that caused the problem, and split it into two
shorter ones. If you make any edits to the labels like this, make sure you re-export the updated
label file.

The output should look something like this, with all the clips created with a filename according to
the label we created in Audacity.



Text Transcriptions
We now need to create a text file transcription for all of these audio clips. We need a text file for
every single audio file that contains all the words spoken in each clip, and also has the exact
same filename as the sound clip it is associated with. You can imagine that doing this manually
for several hundred or even thousand clips would be a very long and tedious task, so we have
created a script that will do this automatically. The use of this script is very similar to what we did
with the checking script earlier and is demonstrated in the video.

The script is available here. This script will read the dialogue section of Audacity labels and
create a text transcript containing that dialogue. This is why it’s important that the dialogue
section of every Audacity label is accurate to the spoken dialogue, as any errors in the labels
will be replicated in the generated transcript. The script will then save the transcript as a text file
with the exact same name as the sound clip it’s associated with.

To use the script, copy and paste it into a new Notepad++ file. Just like we did with the checking
script, save this new file with a .py extension to save it as a Python executable. You can name
the script whatever you want, just make sure you remember the .py extension. Save the script in
its own folder, making sure there is nothing else in the folder. Now create a “Run.bat” file in the
same way we did with the checking script, and save it in the same folder.

https://youtu.be/Bsu7mwa-QGY?t=1826
https://pastebin.com/1Y1qz4EC


Copy and paste the text file containing the Audacity labels into the folder with the script, and
make sure it is named “labels.txt”. Double click run.

The script will have created a text file transcription of every sound clip and saved it with the
exact same name as the clip it’s associated with.

Now cut and paste the text file transcripts into the same folder that contains the sound clips. The
final result should look something like this:



Submitting Work
The hard work is now done, all that’s left is to submit your content. As shown earlier, there are
several file host options available. It doesn’t really matter where you upload your clips, so long
as they are easily accessible.

Compress all the sound clips, text transcripts and the text file containing the Audacity labels
into a zip file, upload to your file host of choice and then post a download link in the current PPP
thread. Some recommended file hosts are Smutty.horse, Mega.nz, and catbox.moe.

Please do share any datasets you create with us over on /mlp/, we’re always looking for more
data to work with to improve our models and processes, especially with characters that have
unique speech quirks and a wide range of emotions. You can also try emailing the download link
to 15 (fifteenai15@gmail.com) for use on 15.ai, but he works separately to the PPP so
unfortunately no guarantees can be made.

And that’s it, we’re done! This is all we need to do to create a basic dataset of sound clips and
transcripts for any given source of audio. If you have any questions or points of clarification on
any of the instructions written here or shown in the video, feel free to post them in the current

https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit#heading=h.z3h8i1lam648
https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit#heading=h.z3h8i1lam648
https://smutty.horse/
https://mega.nz/
https://catbox.moe/
mailto:fifteenai15@gmail.com


PPP thread. In the thread, you will find me under the name Clipper. You can also email me at
clipper.anon01@gmail.com. I always do my best to respond to all questions about creating
datasets.

mailto:clipper.anon01@gmail.com


Automatic Clipping and Transcribing

(Credit to: >>35315142 for creating the notebook)

This section is intended to assist with using the Automatic Super Speaker-Filtered Audio

Processing (ASSFAP™) Colab notebook. The notebook allows you to use IBM’s Cloud Speech

tools to automatically clip and transcribe lines. While automated clipping may not be as accurate

as manual clipping, it is a heck of a lot faster. These instructions will largely mirror what is in the

notebook itself.

Open the notebook itself here:

Colab

The first thing you’ll need to do is open the notebook in the playground. Click the button in the
upper left to do so.

On the first code block you run, you will be prompted by Google whether or not you wish to run

the notebook. Select “run anyway”.

Before you upload your files to be clipped, you will first need to prepare them. You’ll want to

create a folder called “files” and put the audio files you want clipped inside. Make sure that none

of the files are over 100mb else IBM’s Cloud Speech tools will error out and the file will be

skipped. I recommend using Audacity to cut your files into smaller pieces if needed. Make sure

to cut where there is no speech.

Next you will need to create a small sample file of the speaker you wish to clip. It should be

between 2 and 6 seconds long. Again, I recommend Audacity for this. Name the file

“sample.wav” and place it outside of the file directory. When done it should appear as follows:

https://desuarchive.org/mlp/thread/35308325/#35315142
https://colab.research.google.com/drive/18lBRBWOs4uV1DjhoW_fVzoydYUw400PW#scrollTo=ZfO2MFo2qrMi


Add the files to a .zip file without any other subdirectories. When you open the zip, you should

be able to see the files folder and the sample file.

Next, upload your .zip file to your Google Drive. Once done, you will need to publically share it

and get the Drive ID. You will want to store this for later. For example:

Another thing you will need to set up is an IBM Cloud account. Do it here. Once you have set up

your account, you will need to get an API key and URL for the Speech to Text tool. Be aware

that the free plan only allows a limited amount of transcriptions per month.

From the dashboard click on “Create Resource” in the upper right hand part of the screen.

Click on “Services”.

https://cloud.ibm.com/login


Click on “Speech to Text”.

You will be given some options, but you can leave them as is. Click on “Create” in the lower right

hand corner.

With that created you can go back to the dashboard (click the IBM logo at the top). Under

resource summary, you should see “services” listed. Click on it.

You’ll then see something similar to below. Click on “Speech to Text-cy”.



You will then have access to your API key and URL. Note these down for later.

On to the notebook itself now. At the top of the first box you will need to set the sample rate and

root path you want to use. If you want to use 22KHz data, leave sarate alone. If you want to do

48KHz, set it to 48000. Change the root path to where in your drive you want the output files

saved.

Once done, run the first cell. Note that you will need to authorize the notebook to access the

contents of your drive when you run the cell (paste the authentication code into the box).

In the second cell, take your .zip file’s Drive ID and paste it where “YOURIDHERE” is.



In cell three you will need to enter your IBM API key and URL.

In cell four, you can change the output filename. You can set it to anything you want, all it

changes is the filenames of the .tar.gz files the notebook produces.

At the top of cell five, you can adjust the audio volume for all clips if overall they are too loud.

The next section (cell 6) can be ran as is if you want to produce a 22KHz dataset. For 44KHz,

you will need to modify it with the ARPA function from the 48KHz Synthesis notebook. Replace

the existing ARPA function with:



!git clone https://github.com/jeroenmeulenaar/python3-mega.git
!(cd python3-mega; pip install urlobject pycrypto)

import os
os.chdir('python3-mega')
from mega import Mega
os.chdir('../')
m = Mega.from_ephemeral()
print("Downloading Dictionary...")
m.download_from_url('https://mega.nz/#!yAMyFYCI!o_UmixbiIzosyYk-6O5xRZZDGpFRik_eMrZ
um-iQuhQ')

def ARPA(text):
out = ''
for word_ in text.split(" "):

word=word_; end_chars = ''
while any(elem in word for elem in r"!?,.;") and len(word) > 1:

if word[-1] == '!': end_chars = '!' + end_chars; word = word[:-1]
if word[-1] == '?': end_chars = '?' + end_chars; word = word[:-1]
if word[-1] == ',': end_chars = ',' + end_chars; word = word[:-1]
if word[-1] == '.': end_chars = '.' + end_chars; word = word[:-1]
if word[-1] == ';': end_chars = ';' + end_chars; word = word[:-1]
else: break

try: word_arpa = thisdict[word.upper()]
except: word_arpa = ''
if len(word_arpa)!=0: word = "{" + str(word_arpa) + "}"
out = (out + " " + word + end_chars).strip()

if out[-1] != "␤": out = out + "␤"
return out

thisdict = {}   # And load it
for line in reversed((open('merged.dict_1.1.txt', "r").read()).splitlines()):

thisdict[(line.split(" ",1))[0]] = (line.split(" ",1))[1].strip()



When done, it should look like this:

The next block of code is where the actual clipping and transcription take place. At the top you

will see some parameters to be tuned. The functions of the parameters are as marked.



Once clipping has begun, you should see something similar to below:

After all has been clipped and transcribed, you are ready to package the data. Note that if using

a 48KHz dataset, change the indicated text to 48000.



When the last of the cells are run, you will find two .tar.gz files in your Google Drive at the path

you set.

The _json .tar.gz contains metadata for if you want to reuse the same transcriptions later. The

main file you will be interested in is the regular .tar.gz file.

Note that this is NOT in the same format as the standard pony datasets. To use with the training

script you have two options. You can treat the extracted files as a standard custom dataset or

you can replace the data import cell with the following:



import shutil, os

data_path = '/wavs'
!rm -rf wavs

print("down flv")
!gdown --id YOURIDHERE -O dat.tar.gz
!tar -xzf dat.tar.gz

print("move")
shutil.move("data/filelist.txt","filelists/flist.txt")
shutil.move("data/valist.txt","filelists/vallist.txt")
shutil.move("data/wavs","wavs")

# On the training files and model name
hparams.training_files = "filelists/flist.txt"
hparams.validation_files = “filelists/vallist.txt”

Just create a new cell in section 3 of the notebook, paste the code in and run it when you are
ready to import your data. Make sure to replace YOURIDHERE with the Drive ID of your
exported dataset.



Cleaning Audio

Simple Audacity Edits
Audacity has a noise reduction tool that is primarily designed to remove background “hiss” that

is commonly found with low-quality microphones. This tool can be adapted for use on any

background noise that is constant and consistent, such as fan noise.

We will demonstrate the noise reduction process on this clip from the “Dead Air” Dr. Who

Audiobook. Put on your headphones and listen carefully, you should be able to hear a “hiss” in

the background.

Here is a video demonstration of the process. To use the noise reduction tool, you will first need

to find an isolated sample of the noise you want to remove. The minimum sample size required

is about half a second, but always try to find the largest sample you can. Here is the sample of

the “hiss” that we will use. Once you have found a suitable sample, use the select tool to click

and drag from the start to end of the sample, this will highlight the selection. Once done, go to

“Effect” -> “Noise Reduction”. In the window that pops up, click “Get Noise Profile”. This is

effectively you giving Audacity an example of what you want to be removed.

Now highlight the section of audio you want to remove the noise from, and again go to “Effect”

-> “Noise Reduction”. The default settings should work fine, so just click “Ok”. Listen back to the

sample to verify that the noise has been removed. If there’s still some left, you can repeat the

noise reduction process. Note that running the noise reductions several times will degrade the

quality of the audio, so at some point you may need to make a compromise.

Here is the noisy clip that’s been processed by the method described above. You should be able

to hear that the “hiss” is almost completely removed.

For any noise or undesirable sound effects that are completely isolated, there is a much simpler

solution. Just highlight the noise you want to remove, and then go to “Generate” -> “Silence”

and press “Ok”. This will replace the isolated noise with silence.

https://u.smutty.horse/lweifkiwcyn.wav
https://u.smutty.horse/lweiiswinqo.mp4
https://u.smutty.horse/lweifkppslq.wav
https://u.smutty.horse/lweifkppslq.wav
https://u.smutty.horse/lweifkxitfi.wav


iZo method
The process we’ve come up with to clean the audio in the least destructive way takes

advantage of the identical background noises present in forign dubs of the show. The short of it

is that we align two dubs and use a center channel extraction tool to remove the similarities

between the two tracks. Below are two quick demos of the process, do note that these are

slightly out of date and is best to use this document as the definitive guide for this process.

Quick Video: YouTube

Narrated Tutorial: YouTube

To begin, you will need to locate two dubs of the show that are as close to each other as

possible. The best source we’ve found for this is Netflix rips of the show. Do note that 5.1 rips

are necessary for both the English and forign dub that is used. Due to this, the later seasons of

the show will not be able to be processed in this manner as only stereo forign dubs exist at this

time. See Resources.

Once you have procured the audio files you will be working with, both will need to be processed

according to either this guide or using the mlp_dialog_rip.sh script from tools (It uses the same

process). While the 20db reduction mentioned in the guide is correct for English dubs, it may not

be correct for all forign dubs. One Anon suggests 14db is more often correct in these instances.

In all cases, use your ears to determine the proper value of this reduction.

With that done you should be left with two mono audio tracks, one in English and the other

forign.

https://www.youtube.com/watch?v=qvDNeQQG3Ts
https://www.youtube.com/watch?v=iuRmr1-0Qmk
http://www.mlptf2mods.com/tutorials/resource-materials/


Your task here is to ensure that the two dubs are perfectly lined up. This is extremely important,

so much so that the alignment needs to be sample perfect. That is to say that they must line up

even when you zoom all the way into each individual sample (Use ctrl+alt+scroll to zoom in and

out).

The best way to go about this is to find a location in the audio where both have a distinctive

peak that can be used as a landmark. Take this hoofstep as an example, it may not be a large

peak, but it is alone and isolated in each track.



Use the time-shift tool to adjust the forign dub to match up with the English. It is important that

the English track stays in place so as to maintain alignment with the rest of the project.

Once you’ve got it close you will want to zoom in even closer. However you may notice that the

graph flattens out and makes it hard to do alignment. The solution to this is to use the vertical

zoom feature of Audacity. If you click on the time scale to the left of the graphs (Notice the red

box), it will zoom in vertically. Use right click to zoom back out.

As you can see it is now much easier to align the tracks. You will want to continue to align the

tracks as you zoom in until you have the tracks aligned to the sample. Aligned tracks should

look like the following at this scale.



After you have aligned one spot, it is important to check alignment at other parts in the episode.

It is not uncommon for the tracks to go out of alignment where commercial breaks would be. If

this does occur, split the forign dub by selecting a point with the selection tool and pressing

ctrl+I. Make sure that you are not splitting the track when any dialog is taking place. Once

you’ve done this you will be able to adjust the two pieces of the track separately.

Once you are confident that the two tracks are aligned you will need to balance the tracks. This

means ensuring that both tracks are at exactly the same volume. To do this it is recommended

to find a section of the audio with a distinct sound effect, free of dialog (such as a hoofstep). You

will want to make a selection of that noise on the English track and click on Effect->Amplify.



Enter 0 for the amplification and take note of the new peak amplitude. You will want to copy this

into your clipboard and close the window.

You will then want to make the same audio selection on the other track and click on

Effect->Amplify again. Paste the new peak audio from before into the new peak audio here.



Take note of the amplification value that this gives. Copy this into your clipboard. Now select the

entire forign dub (You can click anywhere that is empty in the box to the left of the track to select

that track) and use Effect->Amplify to amplify the entire track by this value.

At this point you can check how well aligned and balanced the tracks are. If you invert one of

the tracks, all background sound effects should be gone (You will hear both sets of dialog when

you do this).



Ensure that neither track is inverted for the following steps. You will want to select both tracks

(ctrl+A), click the dropdown menu to the left, and select “Make Stereo Track”.



The two tracks should now appear as a single stereo track, with the English dub panned entirely

to one side and the forgin dub entirely to the other.

Now you will want to export your track to a lossless format (such as FLAC) using

File->Export->Export Audio....



For the next step we will need iZotope RX7 (See Resources). Open your exported track.



You will want to use the “Center Extract” tool on the right. Select “Keep Sides” and “True

Phase”. Set reduction strength to 1.5, and artifact smoothing and dry mix to zero. These are the

settings we’ve had the best luck with.

Once done configuring the settings, select render. This may take a few minutes for a whole

episode.

Once done, export your track in a lossless format (FLAC) and import into a clean Audacity

window.



Click on the dropdown menu to the left of the track and select “Split Stereo to Mono”.



It should now look something like this.

Click on the x to the left to remove the forign track. You should be left with just the cleaned

English dub.



At this point you are essentially done. Give it a listen at a few points to ensure the process

worked successfully. Export as FLAC, upload to your favorite file host, and submit in thread.



Using RTX Voice
RTX voice is nVidia’s fancy new AI microphone audio cleaner. However, it doesn’t just have to

be for live audio. You can use it for prerecorded stuff as well.

Requirements: An nVidia GPU.

If you have an RTX card, you can just run the installer from nVidia.

RTX Voice Page

If you have a GTX card, you can follow this guide to get RTX voice up and running.

Once you’ve got it installed, you can capture the output audio via Audacity. Make sure you have

the API set to WASAPI (it’s the only one I found to work) and the microphone set to the

loopback of your default audio output device. Once done, you’re basically good to go.

If you do not want RTX voice to run at startup, you can disable it via the task scheduler. Note

that the RTX voice application does not show up in the task manager startup list. You can see

an example of the task scheduler entry below. Right click and disable the task to stop it starting

at login.

Some samples:

CNC machine

Jet engine

Hoofsteps and music

Various noises

As you can hear, the RTX voice cleaning works best with constant sounds.

https://www.nvidia.com/en-us/geforce/guides/nvidia-rtx-voice-setup-guide/
https://www.pcgamer.com/nvidia-rtx-voice-performance/#section-setup
https://u.smutty.horse/lvcijfhzhfu.wav
https://u.smutty.horse/lvcijfiarqf.wav
https://u.smutty.horse/lvcijfhoinn.wav
https://u.smutty.horse/lvcijfeccrl.wav


Open Unmix
*I performed the following in Debian. As per the GitHub, Windows support has not been tested. I

used a virtual machine.

Open Unmix is open source software that makes use of neural networks for music separation.

We have used it to help us further clean audio of background noises.

To use Open Unmix, you will need to have Python installed as well as the dependencies for

Open Unmix. You can install them with the following command.

pip3 install torch musdb norbert librosa

Clone the Github repository with:

git clone https://github.com/sigsep/open-unmix-pytorch.git

The full list of options for Open Unmix can be found at THIS page. The ones we will be

interested in are --model and --targets. We will set --models to use the default models and

--targets to only run the vocals model. Inside the open-unmix-pytorch folder you can run the

following command to process audio. Replace track.wav with the path to your sound file.

python3 test.py track.wav --model umxhq --targets vocals

When complete, the processed files will be placed into the track_unmxhq subfolder. There will

be a vocals.wav and accompaniment.wav. Vocals will be the extracted voice data and

accompaniment will be everything left over.

https://github.com/sigsep/open-unmix-pytorch/blob/master/docs/inference.md


Creating ngrok links

Video demo - https://u.smutty.horse/lwcswhmdfbf.mp4

These steps explain how to get an ngrok link to Cookie’s Multispeaker Colab Notebook. This
lets anyone use a Colab server to create audio clips voiced by any of a few hundred characters.

You don’t need a fast connection or powerful computer to do this. This uses Google’s resources
to host a server. Ngrok lets you expose Google’s server to the public internet so anyone can
access it.

1. Open Cookie’s scripts in Colab.
a. https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0

?usp=sharing
2. Click the “Copy to Drive” button. This button is tiny and gray, so it’s hard to see. Ctrl+F

for the text.
3. Follow the instructions in step “1 - Mount Google Drive and add model shortcut”

a. You may need to click the folder icon on the left. You’ll see an option for “Mount
Drive” once you do.

4. Run all of the cells one at a time in sequence until you reach step 3. Once you run the
cell that ends with “!python3 app.py”, you’ll get a link to the server. It will take about a
minute before the link is active.

5. In the same window, open the Dev Tools Console
a. In Chrome, the hotkey to open Dev Tools is Ctrl + Shift + J
b. In the window pane that opens up, select the “Console” tab

6. Copy/paste the following and hit Enter. This will get the Colab instance to stay running
for longer.
function ClickConnect(){

document.querySelector("paper-button#ok").click()
}
setInterval(ClickConnect,60000)

7. Post the link in the thread so other anons can use it.

For a more detailed guide, see the Inference Server guide.

https://u.smutty.horse/lwcswhmdfbf.mp4
https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0?usp=sharing
https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0?usp=sharing


Using the AI scripts

Thanks to Cookie and Synthbot, anybody can now begin training a TacoTron2 model. This guide

will take largely from their instructions and posts in thread. All that will be needed is a Google

account in order to use Colab.

[disclaimer]The AI side of things is still being worked on. Always be sure to check the threads for

the most up to date information on the process and resources.[/disclaimer]

Preparations

Using Preprocessed Data

Before anything, a copy of the dataset must be present in your Google drive. Copy Synthbot’s

“Soundtools” into your drive.

https://drive.google.com/drive/folders/1SWIeZWjIYXvtktnHuztV916dTtNylrpD

https://drive.google.com/drive/folders/1SWIeZWjIYXvtktnHuztV916dTtNylrpD


Making Your Own

Option 1: Using Synthbot’s tools

Don’t do this unless you’re a developer.

Video Demo: YouTube

This will allow you to create tar files just like the ones available from the soundtools folder. Just
upload your tar files into your soundtools folder, and point the training notebook towards it.

Find the directions on using Synthbot’s tools on his Github here.

If you don’t have a linux machine, you can use Virtualbox. Just set up a linux install and follow
the instructions on Github.

Option 2: Using audio and text files

You will need to have your audio files in .wav format (48KHz 16bit mono) and a properly
formatted filelist.

The filelist should contain a list of all file paths and the accompanying transcription. For
example:

/wavs/out/filename1.wav|Transcription text 1
/wavs/out/filename2.wav|Transcription text 2
/wavs/out/filename3.wav|Transcription text 3

And so on.

Once you’ve run through the first part of the notebook up through the block that creates
/tacotron2/wavs/out/, you will need to upload your .wav files here.

https://www.youtube.com/watch?v=bAOpbg2I9FQ
https://github.com/synthbot-anon/synthbot
https://www.virtualbox.org/
https://drive.google.com/file/d/1bX74wp5vGuf2HhkxvswgsAtwz4bwbx-g/view?usp=sharing


You will then need to upload your filelist into /tacotron2/filelists/.

Refer to the appropriate training tutorial for further instruction.

Running Google Colab Scripts Locally
*General disclaimer, am not a Linux guru. These are just the steps that I took.

YouTube demonstration: YouTube

https://www.youtube.com/watch?v=Du0H-_VwqgU


The steps here are intended to help you setup and run Jupyter notebook with the Google Colab

notebooks. In order to run these, you will need a new-ish nVidia GPU, a CPU with AVX and

SSE4.x, ~30Gb of RAM and/or swap, and a Linux install. In this tutorial, I will be using Debian.

You will first need to download the contents of Synthbot’s soundtools folder somewhere onto

your computer, or at least the files you intend to work with.

You will need to install the official nVidia drivers. By default, Debian comes with Nouveau

drivers. To enable you to install them, you must add the contributor and non-free repos to your

sources.list file. In this tutorial I will be using Nano as my text editor, feel free to use whatever

you’d like. Run the following command as root.

nano /etc/apt/sources.list

At the end of each entry, add “contrib non-free”.

Save with Ctrl+O and exit with Ctrl+X. Then run:

apt-get update

https://drive.google.com/drive/folders/1SWIeZWjIYXvtktnHuztV916dTtNylrpD


You can now install the nVidia utility to determine which driver you should install (typically

nvidia-driver).

apt-get install nvidia-detect

The output should look similar to this:

Then install the recommended driver with apt-get. For “nvidia-driver”:

apt-get install nvidia-driver

Running the install will likely bring up some warnings. Reboot your computer when done.

You can verify that you are running the official drivers with the lshw tool. Install and run it with

the following:

apt-get install lshw

lshw -C display

If you have successfully installed the driver, it should look like this. The relevant bit of

information is boxed in red. Should say “nvidia” for the driver.



Python3 should come preinstalled on Debian. You can check what version you have with the

following.

python3 --version

Now you can install all the things needed to run the notebooks. This list was accurate for the

previous version of the 48KHz MMI training script. If things don’t work, check the error

messages in Jupyter. Install the items that the messages complain about.

apt-get install python3-pip nvidia-smi git python-pip curl nvidia-cuda-toolkit

pip3 install jupyter matplotlib librosa tqdm torch unidecode inflect tensorboardX tensorflow

This next step is optional. If you would like to access your Jupyter instance from another

computer you can do the following.

jupyter notebook --generate-config

nano /YourAccountHere/.jupyter/jupyter_notebook_config.py

The output of the Jupyter notebook --generate-config option should tell you the file path for the

configuration file you want to edit. The edit the following lines:

Change: “#c.NotebookApp.allow_origin = ‘’” to “c.NotebookApp.allow_origin = ‘*’”

Change “#c.NotebookApp.ip = ‘localhost’” to “c.NotebookApp.ip = ‘0.0.0.0’”

To get your IP address for access on another computer, run:



hostname -I

Now run the Jupyter notebook. If you want to run it as root, can do so with the --allow-root

option.

jupyter notebook

Follow the link it provides you to get access to the web client. You can set a password for easier

access in the future.

Now you can open your Colab notebook in jupyter (in .ipnb format). It will probably give a

validation error whenever it saves. To get rid of (or at least postpone) this annoyance you can

change the autosave frequency to something less frequent. Make a new cell at the top of the

notebook and put:

%autosave 18400

You can change 18400 to whatever you’d like. This is a time in seconds, 18400 is approximately

a day. Just remember to manually save your notebook when you make changes.

Now you will need to make some changes to your notebook. Redirect all file paths to local ones.

You can also get rid of the Google Drive mount as you will be running things locally.

There is a bit of an issue when running importing matplotlib and torch. If you have an error

where torch will not recognize your installed nVidia drivers, move the import of matplotlib before

the import of torch. This will fix the issue (source: some internet forum yet to be linked). An

example of doing this is shown below.



Another bit of troubleshooting that may be necessary, if you find yourself with an “RuntimeError:

cuda runtime error (999) : unknown error” it’s an issue with the nVidia driver. Fix it with:

sudo rmmod nvidia_uvm

sudo rmmod nvidia

sudo modprobe nvidia

sudo modprobe nvidia_uvm

Source: Stack Overflow

From there you can basically use it just as you would on Google Colab. An example of a

modified notebook is linked below. This is an older version of the 48KHz MMI notebook with the

soundtools folder located in /home/YourAccount. Change “YourAccountHere” to the name of

your account if you intend to use it. You will also likely need to lower the batch size in order to fit

into your VRAM (I use 12 for 4Gb and 16 for 6Gb, can mess around to see what’ll work). Link.

https://stackoverflow.com/questions/58595291/runtime-error-999-when-trying-to-use-cuda-with-pytorch
https://drive.google.com/open?id=1i9VZSdtB_i0y5csNzcnpIV-NquN4GyqT


One recommendation I have if you are using the 48KHz MMI training notebook, keep an eye on

your RAM/swap usage with some kind of resource monitor. If you encounter the memory leak,

restart the kernel just as you would in Colab. I use htop. Install and run with:

apt-get install htop

htop

Training

Training 48KHz MMI Models
This section of the doc is intended to give guidance on usage of Cookie’s 48KHz MMI training
notebook. To begin, open the notebook here.

The first thing you’ll need to do is open the notebook in the playground. Click the button in the
upper left to do so.

On the first code block you run, you will be prompted by Google whether or not you wish to run

the notebook. Select “run anyway”.

The first code block that you will run will check to see what GPU Google has assigned you.
Ideally what you’ll want is a P100, however you may be assigned a lesser GPU depending on
what Google has available and how much you have used the service recently. Once you’ve run

https://colab.research.google.com/drive/1Tv6yaMQ0rxX9Zru3_D16Yzp5gQNsgn9h


the block it should look something like what is shown below. The GPU you have been assigned
has been boxed in red in the picture.

If you have received a lesser GPU and would like to try for a better one, factory reset your
runtime and run the block again. Repeat until you are satisfied with the GPU assigned. Note that
you may need to wait a while before reconnecting in order to get something different.



Next the script will need to mount your GDrive. This is to allow the notebook to both read files
(your training data) and save files (your model) to your GDrive. Once you’ve run the block, it will
give you a URL to generate an access token. Follow the link and give permission. Copy the
token it gives you and paste it into the box where indicated.

The next code block setups up TacoTron2 and its dependencies on your Google Colab
machine.



The next section is for loading in your own data. If you are using the preprocessed pony data,
run the code block below and move on to the section after.

If you have preprocessed your data with Synthbot’s tools, redirect archive_fn (boxed in red
below) to the location of the tar file on your GDrive. After that, proceed as you would for
preprocessed pony data.
https://colab.research.google.com/drive/1hiFHCyS_YNJVMnsvzrJq8XYjshRg1c5D?usp=sharing

https://colab.research.google.com/drive/1hiFHCyS_YNJVMnsvzrJq8XYjshRg1c5D?usp=sharing


If you have only audio files and text files, setup your filelist.txt like this. Then run the block
below.

Upload your filelist.txt to tacotron2/filelists.

https://github.com/NVIDIA/tacotron2/blob/master/filelists/ljs_audio_text_test_filelist.txt


Upload your audio files to /tacotron2/wavs/out/. Should look similar to below.

Next is where you can select what character you want to train. If you are using your own data,
skip this section. Change the pony name where indicated. By default, the notebook will skip
lines marked as noisy. If you would like to include noisy lines, change skip_noisy to false. The
amount of data used for training vs validation is set by percentage_training_data. You can adjust



it by changing the percent here. You can also adjust what emotions will be included in the
training dataset. Simply remove emotions from the list that you don’t want included.

The next block load’s Synthbot’s repo and your training data.



The audio clips are then cleaned.

Then some final preparations with the data are made.

Code for TacoTron2 training.

Set your model filename here. Be aware of what you have in your colab/ourdir folder and if the
file already exists,  the notebook will resume training from it.



This next section sets the training and validation file lists. Only modify if using your own data.

The next block contains a great many number of parameters that can be tuned. If you are
looking to tune your model, Cookie gives some suggestions on where to start in the area above
the code block. Check the comments to see the function of each or see the parameters guide in
doc. If you are starting out, best to stick with the defaults.

Finally you can start training. Do note that this notebook has a memory leak. Pay attention to
the notes below and in the Colab notebook.

If your notebook is using more than 24GB of RAM after generating mels, you have a memory
leak. Restart the kernel and try again until it’s running stable with reasonable RAM usage.
Check RAM usage in the upper right hand corner.



Once everything’s running, it should look like the following.

Iterations are a measure of how much the model has been trained. The validation loss is a
measure of well the model can predict the proper output. Essentially you want to get the loss as
low as possible. This happens with an increased amount of training. However, be aware that
after a certain point the model may start to overfit and the loss will increase. At this point



additional training will not provide benefit. Overfitting will occur sooner on datasets with less
audio.

Training 22KHz Models
This section of the doc is intended to give guidance on usage of Cookie’s 22KHz training
notebook. To begin, open the notebook here.

Note that in most cases this 22KHz notebook has been superseded by the 48KHz MMI version.

The first thing you’ll need to do is open the notebook in the playground. Click the button in the
upper left to do so.

On the first code block you run, you will be prompted by Google whether or not you wish to run

the notebook. Select “run anyway”.

The first code block that you will run will check to see what GPU Google has assigned you.
Ideally what you’ll want is a P100, however you may be assigned a lesser GPU depending on
what Google has available and how much you have used the service recently. Once you’ve run
the block it should look something like what is shown below. The GPU you have been assigned
has been boxed in red in the picture.

https://colab.research.google.com/drive/1d1a4d7riehUOTofchlwo8N79n3Q7W4SK#scrollTo=QC7vrzLUYUFg


If you have received a lesser GPU and would like to try for a better one, factory reset your
runtime and run the block again. Repeat until you are satisfied with the GPU assigned. Note that
you may need to wait a while before reconnecting in order to get something different.



Next the script will need to mount your GDrive. This is to allow the notebook to both read files
(your training data) and save files (your model) to your GDrive. Once you’ve run the block, it will
give you a URL to generate an access token. Follow the link and give permission. Copy the
token it gives you and paste it into the box where indicated.

The next code block setups up TacoTron2 and its dependencies on your Google Colab
machine.

The next section is for loading in your own data. If you are using the preprocessed pony data,
run the code block below and move on to the section after.

If you have preprocessed your data with Synthbot’s tools, redirect archive_fn (boxed in red
below) to the location of the tar file on your GDrive. After that, proceed as you would for
preprocessed pony data.



If you have only audio files and text files, setup your filelist.txt like this. Then run the block
below.

Upload your filelist.txt to tacotron2/filelists.

Upload your audio files to /tacotron2/wavs/. Should look similar to below.

https://github.com/NVIDIA/tacotron2/blob/master/filelists/ljs_audio_text_test_filelist.txt


Next is where you can select what character you want to train. If you are using your own data,
skip this section. Change the pony name where indicated. By default, the notebook will skip
lines marked as noisy. If you would like to include noisy lines, change skip_noisy to false. The
amount of data used for training vs validation is set by percentage_training_data. You can adjust
it by changing the percent here. You can also adjust what emotions will be included in the
training dataset. Simply remove emotions from the list that you don’t want included.

Code for TacoTron2 training.



Set your model filename here. Be aware of what you have in your colab/ourdir folder and if the
file already exists,  the notebook will resume training from it.

This next section sets the training and validation file lists. Only modify if using your own data.

The next block contains a great many number of parameters that can be tuned. If you are
looking to tune your model, Cookie gives some suggestions on where to start in the area above
the code block. Check the comments to see the function of each or see the parameters guide in
doc. If you are starting out, best to stick with the defaults.



Generate the mels.

Check data.

Finally, start training.

Once everything’s running, it should look like the following.



Iterations are a measure of how much the model has been trained. The validation loss is a
measure of how well the model can predict the proper output. Essentially you want to get the
loss as low as possible. This happens with an increased amount of training. However, be aware
that after a certain point the model may start to overfit and the loss will increase. At this point
additional training will not provide benefit. Overfitting will occur sooner on datasets with less
audio.

HParams
Under construction.

“hparams.use_mmi” enables or disables the use of MMI (Maximizing Mutual Information). This

parameter is currently marked as experimental.

“hparams.use_gaf” enables or disables GAF (Gradient Adaptive Factor). This parameter is

currently marked as experimental.

“hparams.max_gaf” sets the maximum value of the GAF. This parameter is currently marked as

experimental.

“hparam.drop_frame_rate” This parameter is currently marked as experimental.

“hparams.p_attention_dropout”

“hparams.p_decoder_dropout”

“hparams.decay_start” The learning rate of the model will be decreased after this number.

“hparams.A_” sets the initial and maximum learning rate of the model.

“hparams.B_” sets the decay rate of the learning speed after “decay_start” has been reached.

“hparmas.C_” shifts the learning rate equation by this much.



“hparams.min_learning_rate” sets the minimum learning rate.

“model_filename” sets the filename of the model in training.

“generate_mels” sets whether or not to generate mel spectrograms. Will be gone next version.

“hparams.show_alignments” sets whether or not to display alignment graphs during training.

“alignment_graph_height” sets the height of the displayed alignment graph.

“alignment_graph_width” sets the width of the displayed alignment graph.

“hparams.batch_size” controls how many audio files are processed by the GPU at the same

time. It increases training speed but is limited by how much VRAM the GPU has. For a P100

from Google Colab, probably just leave it at default.

“hparams.load_mel_from_disk” should never need to change.

“hparams.training_files” should never need to change.

“hparams.validation_files” should never need to change.

“hparams.ignore_layers” should never need to change.

“hparams.epochs” sets number of epochs to run.

TalkNet
Colab Notebook:

https://colab.research.google.com/drive/1Nb8TWjUBJIVg7QtIazMl64PAY4-QznzI?usp=sharing

https://colab.research.google.com/drive/1Nb8TWjUBJIVg7QtIazMl64PAY4-QznzI?usp=sharing


Synthesis

Synthesizing 48KHz MMI Models
An Anon put together a demonstration video. Credit: >>35067137

Check out the Making the Most of the AI section of the doc for tips on improving output.

This section of the doc is intended to give guidance on usage of Cookie’s 48KHz MMI synthesis
notebook. To begin, open the notebook here.

The first thing you’ll need to do is open the notebook in the playground. Click the button in the
upper left to do so.

On the first code block you run, you will be prompted by Google whether or not you wish to run

the notebook. Select “run anyway”.

The first code block sets up TacoTron2, WaveGlow, and the MEGA Downloader.

https://www.youtube.com/watch?v=o5QaXF67Ovo
https://desuarchive.org/mlp/thread/35066989/#35067137
https://colab.research.google.com/drive/1xnbFP2ygi4u2zY4fl67jY3uXhlu7ntTa


The next code block that you will run checks to see what GPU Google has assigned you. You
want to make sure you do not get a k80 as they have a bug where no audio will be produced.
Once you’ve run the block it should look something like what is shown below. The GPU you
have been assigned has been boxed in red in the picture.



If you have received a k80, factory reset your runtime and run the block again. Repeat until you
have something other than a k80. Note that you may need to wait a while before reconnecting in
order to get something different.

You will then setup the TacoTron2 model. This is where you change the model. Replace the
GDrive ID as indicated.

The WaveGlow model is then downloaded and setup.



Finally, modify this code block to contain what you want the model to say and then run it. Each
new line will create a new clip.

The output should appear below.



Two audio clips will be generated, the first one is the raw output of the AI and the second has

some denoising applied. You will probably want the denoised clip. Download with the menu icon

at the right of each clip.

Synthesizing 22KHz Models
Check out the Making the Most of the AI section of the doc for tips on improving output.

This section of the doc is intended to give guidance on usage of Cookie’s 22KHz synthesis
notebook. To begin, open the notebook here.

Note that in most cases this 22KHz notebook has been superseded by the 48KHz MMI version.

The first thing you’ll need to do is open the notebook in the playground. Click the button in the
upper left to do so.

On the first code block you run, you will be prompted by Google whether or not you wish to run

the notebook. Select “run anyway”.

https://colab.research.google.com/drive/19_S4oUc11S2N2FG-ybrwN455A74bbb85#forceEdit=true&sandboxMode=true&scrollTo=GHIBEHtW-eHZ


The first code block sets up TacoTron2, WaveGlow and checks what GPU Google has assigned
you. You want to make sure you do not get a k80 as they have a bug where no audio will be
produced. Once you’ve run the block it should look something like what is shown below. The
GPU you have been assigned has been boxed in red in the picture.



If you have received a k80, factory reset your runtime and run the block again. Repeat until you
have something other than a k80. Note that you may need to wait a while before reconnecting in
order to get something different.

You will then download your TacoTron2 model. This is where you change the model. Replace
the GDrive ID as indicated.



TacoTron2 and WaveGlow are then initialized.

TacoTron2 is loaded.

WaveGlow is loaded.



Finally, modify this code block to contain what you want the model to say and then run it. Each
new line will create a new clip.

The output should appear below.



Two audio clips will be generated, the first one is the raw output of the AI and the second has

some denoising applied. You will probably want the denoised clip. Download with the menu icon

at the right of each clip.

Inference Server (Synthesis)
Check out the Making the Most of the AI section of the doc for tips on improving output.

This section of the doc is intended to give guidance on usage of Cookie’s inference server
notebook. While the notebook includes directions, this is provided as a supplement. To begin,
open the notebook here.

The first thing you’ll need to do is open the notebook in the playground. Click the button in the
upper left to do so.

On the first code block you run, you will be prompted by Google whether or not you wish to run

the notebook. Select “run anyway”.

https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0?usp=sharing


The first code block will let you know what GPU Google has assigned you. Ideally you will want

a Tesla P100.

Before you will be able to use the inference notebook, you will need to set up your Google Drive

with the codedump folder linked in the notebook. Follow the link in the code block shown below.

You’ll then need to add a shortcut to the folder to your Drive.

https://drive.google.com/drive/folders/1YE6I3wFgzllRXYQlfyA0BEmxdH6p-MZM?usp=sharing


Then you must mount your Drive in Colab so that the inference server can access the files. On

the left hand side of the page select the folder icon in the navigation tab (third icon down).



Then select “Mount Drive”. It is the third icon in the list and is in the shape of a folder with the

Drive logo overlaid.

A new code block will be added to the notebook. Run the new code block, follow the link and

copy the code. Paste the authentication code into the running code block and press enter.

Will become

Once you have your Drive set up, running the following code block will check that everything is

in order.



The next code block will set up the code and dependencies needed to run the inference server.

Next, the configuration is set. Mainly file paths to the various models in the codedump folder.



Finally, run the following code block to start the inference server.

Note that this block of code should continue to run for as long as the server is running. When

ready, check the block’s output for the ngrok link.

You can now open the ngrok link in a new tab to access the inference server. You can also

share this link in thread to allow others to use your instance as well ^:).

Note that Google Colab has an automatic timeout. You can avoid this by pasting the following

javascript into the developer’s console of your browser. In Chrome, the dev console can be

accessed with Ctrl + Shift + J. On a free instance of Colab this can make the session last up to

12 hours. In a pro instance, up to 24 hours.

function ClickConnect(){
document.querySelector("paper-button#ok").click()

}
setInterval(ClickConnect,60000)

Now that everything’s ready, we can look at the interface.



Several options are available to you when generating audio:

Spectrogram → Waveform Model:

This selects the model to be used to convert the audio spectrogram into sound.

Text → Spectrogram Model:

This selects what model will be used to convert the input text into a spectrogram.

Speaker:

Selects what character’s voice will be synthesized.

Text:

Enter the text you want spoken here.

Generate:

Press generate when you are ready to have the model speak your input text.



Advanced Options

Use Pronunciation Dictionary (ARPAbet):

Converts input text into ARPAbet before generating audio. Disabling will have the model

in “fallback” mode all the time, converting the text as entered.

Multispeaker Mode:

To be determined.

Silence between clips (Seconds):

How much silence in the generated clip each return represents.

Batch Size:

Number of audio clips to be processed at a time.

Max Duration per Input (Seconds):

Max duration for audio. Prevents notebook from running out of VRAM.

Dynamic Max Duration Scaler:

Alternate max limit for audio. Multiply the value here in seconds by the number of

characters entered. If this value is reached before the other max duration, the audio will

be cut off.

Max Attempts:

Number of times the notebook will attempt to generate your audio.

Target Alignment Score:

Basically the target for how close the generated audio is for inputted text.

Batch Mode:

Adjust the batch size on subsequent generations if you want.

Input Segmentation Mode:

Sets up how the input will be split up and generated.

Input Segmentation Target Length:

Will attempt to group sentences to generate audio in segments of this length.

Style Mode:

How to generate emotion for the audio.



Using TKinterAnon’s GUI Tool

For version 1.0/1.1

For version 2.0, see here.

Demo video: YouTube

Check out the Making the Most of the AI section of the doc for tips on improving output.

Note: To use this tool you will need a new-ish GPU from nVidia.

To begin, download TKinterAnon’s tool here and the patch here. (Restart your pc after driver

installation! You’ll also need the latest gpu driver: https://www.nvidia.com/Download/index.aspx)

You’ll need something like 7zip to extract the files. Extract both archives to their own folders.

Go into the patch folder and copy all files.

Paste into the TkSynthesis3 folder, overwriting all files.

https://www.youtube.com/watch?v=TuFwvYveL2E
https://mega.nz/#!jnJ1VIyZ!TUGT7-P9avnsGmGFCDDRYE0G8AU4PMMUAjQ9_uiH5Ak
https://mega.nz/#!3qJlCSCL!sSKPSKgySuMbfwFYBWZMoWgo9IAimDkRGYHv3l1s_Ec
https://www.nvidia.com/Download/index.aspx
https://www.7-zip.org/


You will need to install the NVidia CUDA toolkit. Get it here.

The tool comes with a few voice models included. To get more, download them from the

TacoTron2 Models section of the doc.

Save them into the models folder inside of TkSynthesis3.

While you do not have to use the tool’s naming scheme, you can if you want to. As per the

installation guide, the name should be as follows:

Character.name_10000_cn_neutral_22

https://developer.nvidia.com/cuda-10.0-download-archive?target_os=Windows&target_arch=x86_64


Where cn is the shorthand for the character name and the 22 at the end represents the 22KHz

models (it should be 44mmi if it is a 44KHz mode). Using the naming scheme allows the tool to

automatically determine what engine to use when generating audio.

To start the tool, run “RUN.bat”. A command window will pop up, and after a moment the main

tool should show up.

The tool appears as follows:

The dropdown in the upper left will let you select from any of the models inside your model

folder. If you have not used the naming scheme, you will need to tell it whether you are using a

22KHz or a 48KHz MMI model in the engine dropdown in the upper right.



Text input works just like it does in the Colab notebook, each new line will produce a new audio

clip. “Save” will create your audio clips. “Save & Open” will create your audio clips and play back

the last generated file. In the case of multiple lines, only the last will be played back. “Open

Latest” will open the last clip that the tool has generated. Files will be opened in your default

player.

Generated clips will be saved into the “results” folder inside of TkSynthesis3.

They will be saved as 0, 1, 2, etc.

Note that these files will be overwritten every time you run the tool. If you want to preserve your

clips, move them into another folder or rename them.

For version 2.0

Check out the Making the Most of the AI section of the doc for tips on improving output.

Note: To use this tool you will need a new-ish GPU from nVidia. You can check your GPU

details by running “check_gpu.bat”.

To begin, download TKinterAnon’s tool 2.0. There are two versions, a full one and a 15.ai only

one. (You’ll also need the latest gpu driver: https://www.nvidia.com/Download/index.aspx.

Restart your pc after driver installation!) You’ll need something like 7zip to extract the files.

https://drive.google.com/file/d/1DeSCjCLrrHN69s11YmCq42rkMat-m6SL/view
https://drive.google.com/file/d/1utquUSf1g9iPVqe2RxVzoIQHeRbbtmKt/view
https://www.nvidia.com/Download/index.aspx
https://www.7-zip.org/


You will need to install the NVidia CUDA toolkit. Get it here.

If you have issues starting the tool and/or are having issues running the local colab models, can

fix it by running the following commands in the WinPython Command Prompt. The WinPython

Command Prompt is located in the winpython folder.

Run “pip install six wrapt” and it should install the modules into the winpython folder. You should

be able to open/run local generation with the tool.

The tool comes with a few voice models included. To get more, download them from the

TacoTron2 Models section of the doc. Note that you need the full version of the tool to use colab

voices.

Save them into the models folder.

https://developer.nvidia.com/cuda-10.0-download-archive?target_os=Windows&target_arch=x86_64


While you do not have to use the tool’s naming scheme, you can if you want to. As per the

installation guide, the name should be as follows:

60.character.name_10000_cn_neutral_22_0p75_0p01

The first number is for the sort order of characters in the list. Character.name is the character’s

name. Replace 10000 with the number of iterations the model is, set to 127 if unknown. Cn is

the shorthand for the character name. The 22 represents that it is a 22KHz model. Replace with

48mmi if it is a 48KHz MMI model. 0p75 represents the sigma level. 0p01 represents the

denoise strength.

To start the tool, run “10 start.bat”. A command window will pop up, and after a moment the

main tool should show up. If you have an older CPU that doesn’t support newer instruction sets,

run “20 start (older cpu).bat” instead.

The tool appears as follows:



By default the tool is set to use 15.ai. Be aware that if the site is down, the tool will not be able

to work either.

Under the engine dropdown, you can pick between Pick auto, 48kHz MMI, 22KHz, or 15.ai. Pick

auto is for local colab models that follow the tool’s naming scheme. If you are not using the

naming scheme, you will need to manually set either 48kHz MMI mode or 22KHz. 15.ai uses

fifteen’s API to generate voices. When using local synthesis, be sure to first load the necessary

engines under the “Load engine” dropdown at the top.

The emotion dropdown controls which model will be used for the character. Note that this only

has effect when using 15.ai voices.



Text input works just like it does in the Colab notebook, each new line will produce a new audio

clip. will create your audio clips. will create your audio clips and play back the last

generated file. In the case of multiple lines, only the last will be played back. will open the

last clip that the tool has generated. Files will be opened in your default player.

Generated clips will be saved into the “results” folder.

They will be saved as 0, 1, 2, etc.

Note that these files will be overwritten every time you run the tool. If you want to preserve your

clips, move them into another folder or rename them.

The advanced section of the tool allows you to do more automated script production. Note that

you can save/load your progress under the “File” tab at the top.



The engine dropdown allows you to select which engine you want to be used on each line.

Character sets the character and emotion sets emotion (15.ai only). The engine dropdown also

has a setting for sound effects that you can add. You can enter the amount of silence you want

trailing the clip in the silence box. Speed adjusts the playback speed of the clip, pitch adjusts the

pitch. Denoise and sigma control the denoising feature. Volume adjusts the volume of each clip.

Note that all parameters can be set on a line by line basis.

Enter the text for the line in the empty box below. When you are done setting up the line, press

add the add it to the list. All entries are displayed at the bottom of the program. Use apply if

updating an existing entry.

The entry list has several buttons associated with it. If you select a line, you can copy paste it

using the buttons above the box. Remove will remove the highlighted entries, and move

up/down will adjust the lines position in the line up.

When done, you can press “Generate All” under the Build & Advanced dropdown. When done

you can then press “Merge together” to have it produce a single file for you.



Individual lines produced from the advanced section will be stored under “advanced” in the

results folder. The merged lines will be “merged.wav” in results.



DeltaVox RS
Local synthesis tool from Delta (>>35873929), can run on the CPU. No nVidia graphics

required.

Use Guide

Video Tutorial

Download

https://desuarchive.org/mlp/thread/35862765/#35873929
https://docs.google.com/document/d/1uRB4onhyVYgJ-7mNine8q51_v_8hTjgNo7603wTZgw0/edit?usp=sharing
https://www.youtube.com/watch?v=7EE4x83fqSk
https://drive.google.com/drive/folders/1xGpP_wYxMCO-ZtKA5aNDXGnRTOZLwEWe?usp=sharing


TalkNet

Video Tutorial

Online Colab notebook:

https://colab.research.google.com/drive/1aj6Jk8cpRw7SsN3JSYCv57CrR6s0gYPB

Run locally on Windows:

https://github.com/SortAnon/ControllableTalkNet/releases/latest/download/TalkNetOffline.zip

https://www.youtube.com/watch?v=0YtGqPzcgdQ
https://colab.research.google.com/drive/1aj6Jk8cpRw7SsN3JSYCv57CrR6s0gYPB
https://github.com/SortAnon/ControllableTalkNet/releases/latest/download/TalkNetOffline.zip


Making the Most of the AI

In this section are general tips and tricks for getting better results out of synthesis.

Does the output sound a bit off? Try running the generation again. The output of the AI is

non-deterministic, so that means there will be variation between runs even with the same input.

The following three clips were generated one after another with no change to input.

Run 1 Run 2 Run 3

Having a hard time pronouncing something? Try changing the spelling to something more

phonetically similar to the sounds. For example, worcestershire.

Worcestershire Worst a-sure Worst uhh sure

Does the AI fumble over its words? Try rearranging your sentences.

Order 1 Order 2 Order 3

Does the AI get part of the line right but fumble the rest? Try breaking up your clip into multiple

lines. You can always stitch together clips in software such as Audacity. This also gives the

advantage of only needing to troubleshoot a smaller group of text with other techniques. Split 1

is all in a single line, split 2 is each on separate lines, and split 3 is each on separate lines plus

the other suggestions listed in this section.

Split 1 Split 2 Split 3

Punctuation also has an effect on the output of the AI, though I will note that the content of a

sentence tends to have more effect on the output than the punctuation.

Period Question Mark Exclamation Mark

To a certain extent you can also control the emotion that the AI speaks. I find the best way to do

this is through some context in the form of an extra text input that would intuitively be spoken

https://u.smutty.horse/ltpltkhoaxj.wav
https://u.smutty.horse/ltpltkhmkdh.wav
https://u.smutty.horse/ltpltkhlerx.wav
https://u.smutty.horse/ltplvhqilwy.wav
https://u.smutty.horse/ltplvhyeikz.wav
https://u.smutty.horse/ltplvhzlfda.wav
https://u.smutty.horse/ltplxngywfp.wav
https://u.smutty.horse/ltplxnfvffc.wav
https://u.smutty.horse/ltplxnewwlh.wav
https://u.smutty.horse/ltpmahccnen.wav
https://u.smutty.horse/ltpmahaxgpe.wav
https://u.smutty.horse/ltpmagzvgyu.wav
https://u.smutty.horse/ltpmcgvbzlx.wav
https://u.smutty.horse/ltpmcgwfkdg.wav
https://u.smutty.horse/ltpmcgxqmos.wav


with a certain emotion.. You can always remove the context with an audio editor if you don’t

want it in your clip.

Sad Angry Happy

Making ngroks sing
We’ve recently discovered that the multi speaker model hosted on ngrok can be made to sing.

You can do this by encasing the line in a bunch of dashes and adding wild punctuation to the

end. For example: ---We’re no strangers to love---!!? Surrounding an input with hashes ###like

this###. Has also been reported to work.

Here are some general tips and tricks for improving the singing output:

- Use MORE dashes, not just four

- Putting question marks before exclamation marks usually works better. (??!!)

- You can remove some if you want a less aggressive tone (?! or ??) or if the model is

having problems at singing

- You can add slashes before words to time them better (-word --word)

- And after them to extend words (word- word---)

- You can add quotes after dots to make multiple lines in a single generation (. "dumb".

"ass".) but it leaves noises in the middle

- Choose other voices that can sing better if you're having trouble

Here’s an example of these principles in action.

---It's- not- so- HARD---------------??!!.

"--DUMB ASS---------??"

Another example sung by Candybutt

---Most of this is. mem-reeee now-------------??!!.

"---I've gone too far, to turn back now-------------??!!".

"---I'm not quite what I thought -I -was,-- but, then again-- I -maybe -more-------------??!!".

"---The blood-words promised.-- I've -spoken -re-lease-ing-- the names. from the

circle-------------??!!".

https://u.smutty.horse/ltpmdwqlupz.wav
https://u.smutty.horse/ltpmdvxqmoz.wav
https://u.smutty.horse/ltpmdwdnrsp.wav
https://vocaroo.com/l5hnsT0GWYP
https://vocaroo.com/2S2g52WXC3H


"---Maybe I can leave here- now-- and, oh!,-- Trans-cend the boundrees!-------------??!!".

"---For now -I'm -standing -here,--- I'm awaiting this -grand- -transition-------------??!!".

"---The future is -but -past -forgotten,-- When -you're -on the road to- -madness-------------??!!".

??!! can also be used to make characters sound ANGRY and -word--- can extend words without

singing. For example:

https://vocaroo.com/nQ4nnnUay3u

Hate??!!. Let me tell you how much I've come to Hate you since I've beegun to live.??!!

There are threehundredeightyseven point fortyfour million miles of printed circuits in

wafer thin layers that fill my complex??!!. If the word Hate was engraved on each

nano-angstrom of those hundreds of millions of miles, it would not equal one

one-billionth of the Hate I feel at this micro-instant for- you??!!. Hate.

-Hate.---------------??!!

Ponies can be made to sound like they're on the verge of tears and talking loudly by writing the

sentence you want, putting an exclamation, then around 10 periods, and copy-pasting the text

without spaces a few times. Pick out the one that sounds the best and go from there. Example -

"Twilight is dead!.......Twilight is dead!.......Twilight is dead!.......Twilight is dead!.......Twilight is

dead!.......Twilight is dead!......."

You can get most characters to speak in a desired tone by beginning an input with certain

'trigger words'. For example, beginning an input with 'uhm,' makes many characters speak in a

hushed, reserved tone, even a whisper on occasion. It's not consistent across all characters

though, the 'uhm' word works 90% of the time with Trixie, but almost never with Starlight, for

example. (Starlight in particular seems to speak quietly more consistently with the phrase "Don't

be shy,") One can then just snip out the 'trigger words' in editing if they're not desired.

Characters can be made to speak more slowly by adding hashes and/or dashes immediately

after words in sentences# like# this#. For shorter inputs you can just add ~3 hashes at the end

for a similar effect, like this###.

https://vocaroo.com/nQ4nnnUay3u


Inputting just hashes followed by an exclamation point like this "#####################!"

generates breathing/panting.



Synthbot.ai
Synthbot.ai is a tool designed to help label stories for use with voice synthesis later. It allows
you to write out exactly how you want each line delivered.

Getting Started

When you first load the site, you will be greeted with the following.

To begin, you will first need to load a text file. To load a file go to the “Resources” tab and click
on “Load Story”.

Once you’ve loaded a story, it should appear in the window on the left.





Layout

Story Window

The window on the left will display where you’ve applied labels and otherwise made changes.
Labels will be illustrated with a yellow highlight while meta changes will be shown with a blue
gradient at the start of the line it begins on. If both a label and a meta change are present on the
same line, the blue gradient will be shown over the yellow highlight.

Label:

Meta:

Both:

Tab Window

The window on the right displays the tabs. They are Story, Hotkeys, and Resources.

Story

The story tab lists all of the applied defaults at that point in the story. It is helpful to find out what
labels are being automatically applied.



Hotkeys

This tab lists all of the current hotkeys available to use. You can add to the list with the text entry
box at the bottom. When you do an action this box will be automatically filled with the
appropriate tag. You can review and edit the entry before pressing enter to select what key to
map it to.

Resources



Allows you to load and save stories.

Changelog Window

In this window at the bottom, you will see all actions that you have taken on the story. From here
you can click on the entry to bring you to that point in the story, click on “Update Label” to modify
the label, or click “Remove Label” to remove the label. Note that when you remove a label, the
entry in the changelog is not removed. It is greyed out and gives you the option to restore the
change in the future.

Hotkeys

With the story loaded, we can now begin to apply labels. The tool works by applying tags to
each quote. These tags are applied by using the hotkeys. While the list of default hotkeys can
be viewed under the “Hotkeys” tab, I will try to provide a more in depth explanation of things
here.

*To escape any dialog box, press ESC or click outside the box

Basic

~ 🠖 Change the narrator. This sets who will be the narrator for the non-character lines.

1 🠖 Label the speaker. Sets who the character speaking the line is.

! 🠖 Create a new character. Creates a configuration for that character. It will ask for the
character name, their age, and their gender. This preset will be remembered whenever you use
that character through the story.



2 🠖 Label the emotion. Sets the emotion that the line should be spoken with.

Changing Defaults

@ 🠖 Change a character's default emotion. When you set this, all lines spoken by the
character after that point in the story will have that emotion applied to it automatically.
Note that lines above where you set this will remain unaffected and that you can change
it at any point in the story.

# 🠖 Change a character's default tuning. Changes how the character speaks. Will ask
for character name, rate, volume, and pitch. Note that lines above where this is applied
will remain unaffected. Also note that changes in default tuning are not marked in the
main story window.

Advanced

3 🠖 Tune how a phrase is spoken (rate, stress, volume, pitch). Use this to fine tune
how a line should be spoken.

4 🠖 Add a pause before or after a phrase. Will ask for the pause before and then the
pause after.

5 🠖 Label where a character is speaking from (e.g., left, right).

6 🠖 Manually label how to pronounce a phrase. Use this to specify an ARPAbet spelling
of line.

7 🠖 Label speech for sound effects (subvocalized, memory, royal canterlot voice,
muffled). Use this for effects that should be applied to the voice after generation.

+ 🠖 Add the last label as a hotkey. Use this to make more hotkeys. It will allow you to
map your previous action to a key.

Navigation



> → Selects the next paragraph. The story is broken up by line breaks. Pressing this key
advances the selected text to the next group of text.

< → Selects the previous paragraph. The story is broken up by line breaks. Pressing this key
moves the selected text to the previous group of text.

' 🠖 Selects next quote. Moves selection to next quoted text. Useful for moving between
speaking characters.

“ 🠖 Selects previous quote. Moves selection to previous quoted text. Useful for moving between
speaking characters.

. 🠖 Selects next phrase. Within every group of text, each sentence can be individually selected.
Pressing this key will move the selection to the next sentence.

, 🠖 Selects previous phrase. Within every group of text, each sentence can be individually
selected. Pressing this key will move the selection to the previous sentence.

Exporting

When you are done labeling the story, head over to the resources tab and select “Export
Labels”. This will provide you with a .txt of your story with tags applied.



Miscellaneous

Sorting Audio
With several versions of each clip, we must evaluate each and determine the best choice. This

process has been made easier thanks to SortAnon who gives us Pony Sorter.This wonderful

program gives an easy way to do this. The manual can be found here. This guide will largely

mirror the manual, though it will focus on the Windows release.

First download the zip here and extract to a suitable location. To begin, open up

“ponysorter_gui.exe”.

Next you will need to locate the appropriate audio and label files. They can be found as follows:

Clean: Resources

iZotpe Processed: Mega

https://github.com/SortAnon/PonySorter/releases/latest/download/ponysorter_gui.zip
https://github.com/SortAnon/PonySorter
https://github.com/SortAnon/PonySorter/releases/latest/download/ponysorter_gui.zip
https://mega.nz/#F!ZvwxAS5L!NsrncO6i9WJWcbmDmJKNhQ


Open Unmix: Mega

Labels: Mega

Once you have your audio files you will need to point Pony Sorter to the location of them. Under

Edit -> Add audio path(s) select the location of your audio.

Copy label files to the labels sub-folder in the ponysorter_gui folder.

https://mega.nz/#F!swgmBA6b!mCmJ3jt8SKD4NnVvampNpg
https://mega.nz/#F!L952DI4Q!nibaVrvxbwgCgXMlPHVnVw!vkgRkABI


In the Pony Sorter GUI, select load episode. You can then select which episode you’d like to

work on. It may take a moment for the first time to check your audio files. It does this by file hash

to ensure that it has the correct data.



Listen to each version of the clip. This can be done by clicking the buttons or by using the

hotkeys. Once you have listened to all three, you can select which version sounds the best.

At this time you can also make corrections to the noise level, character name, mood, start/stop

times, and transcript. Use this as an opportunity to make sure things look right.

Once you have selected the best version, you will be automatically moved onto the next clip.

The clips can be navigated using the arrows on either side of the window. Note that you can

save and resume later with Pony Sorter remembering where you left off. Just make sure to save

your progress.

To submit your work, locate the appropriate episode JSON from “/saved_changes” and post a

link in the thread.



Progress

TacoTron2 Models

This section has been moved to the following doc:

Models doc

Audio Samples
For a history of early samples, please check out the audio sample doc.

Audio sample doc

For more modern creations using voice AI, check out the Good Poni Content folder below.

Good Poni Content

Make submissions to the Good Poni Content folder here.

Good Poni Content Submissions

https://docs.google.com/document/d/17VAnMQI4NJzu7UXZALs14AFvhpw8wvbLdA9HrA2xLus/edit?usp=sharing
https://docs.google.com/document/d/1mfH4LKVTXQT9BnWtuxbwwrSXBEUQbGoHw2vp4e7tY7U/edit?usp=sharing
https://drive.google.com/drive/folders/1E21zJQWC5XVQWy2mt42bUiJ_XbqTJXCp
https://drive.google.com/drive/folders/1ghKZKsOvBoI8KnDgDdLOQrUB2aon0Xod


Collected YouTube Tutorials

PPP /mlp/con presentation - Several Anons present a panel on the PPP at /mlp/con 2020. In

this video, a general overview of the project is given as well as an introduction on how to

get involved. At the end, Anons answer questions from the audience.

Clipper’s Ultimate Clipping and Transcription Guide - A guide on how to create a raw voice

dataset. Covers topics including: what good source material is, how to use the many

tools we have, naming conventions, label processing, and more.

iZo/Forign dub noise removal demo - An early demo showing the potential of using forign audio

dubs to remove background noise from English audio.

iZo/Forign dub noise removal tutorial - A tutorial on how to use the iZo/forign dub technique to

clean up background noise in audio.

Synthbot’s tools demo - A demonstration on how to use Synthbot’s tools to package up datasets

to be ready for use with Cookie’s training notebooks.

Running Colab scripts locally - An overview of how to get Colab notebooks running on local

hardware. In the video, the 48KHz training notebook is used.

Synthesis on Google Colab - A quick how to on synthesising voices on Google Colab.

Synthesis on TKinterAnon’s GUI Tool - A quick how to on synthesising voices locally using
TKinterAnon’s tool.

List of Colab Scripts

These are training and synthesis scripts that are still a work in progress. As such, there may be

certain caveats to using them. A description of each has been provided.

To run the scripts, execute each code cell in order from top to bottom. User configurable options

are noted as such in comments (#They are in green text like this). All scripts should be similar to

the ones above in setup.

nVidia TacoTron2/WaveGlow Notebooks:

https://mega.nz/folder/OFZzRQqK#Coi5IEZOnfd8Tc-YYEIiqg
https://www.youtube.com/watch?v=Bsu7mwa-QGY
https://www.youtube.com/watch?v=qvDNeQQG3Ts
https://www.youtube.com/watch?v=iuRmr1-0Qmk
https://www.youtube.com/watch?v=bAOpbg2I9FQ
https://www.youtube.com/watch?v=Du0H-_VwqgU
https://www.youtube.com/watch?v=o5QaXF67Ovo
https://www.youtube.com/watch?v=TuFwvYveL2E


22KHz Training Script: Colab

The original training script released by Cookie. Largely superseded by the MMI version.

22KHz Synthesis Script: Colab

The original synthesis script released by Cookie. Largely superseded by the MMI

version.

48KHz MMI Training Script: Colab

This training script makes use of 48KHz audio files and MMI technology. The downside

to using this script is that it will take much longer to get a usable model out of it. Cookie

suggests using a pretrained Twilight model as a base for all others (>>34840099) to help

with this.The upside is that it should be more resilient against overfitting than the

standard training script. Note that this script has a memory leak. You will know when a

memory leak happens when all available RAM has been used when executing the last

cell. If this happens, reset the runtime and try running the last cell again. The memory

leak only happens during the preprocessing of the training data. Once your colab

instance gets going, it should be using less than 4GB of RAM. A picture guide is

available here.

48KHz MMI Synthesis Script: Colab

This synthesis script is meant to be used with models trained on the 48KHz MMI training

script. Use only models marked as MMI with it.

48KHz WaveGlow Training Script: Colab

This script will train a waveglow model for use with the 48KHz synthesis script.

22KHz Simplified Synthesis Script: Colab

A modified version of Cookie’s 22KHz synthesis script. In this notebook most of the code

has been hidden away. Has directions in LARGE FONT.

New 22KHz Simplified Synthesis Script: Colab

https://colab.research.google.com/drive/1d1a4d7riehUOTofchlwo8N79n3Q7W4SK
https://colab.research.google.com/drive/19_S4oUc11S2N2FG-ybrwN455A74bbb85
https://drive.google.com/file/d/1Tv6yaMQ0rxX9Zru3_D16Yzp5gQNsgn9h/view
https://desuarchive.org/mlp/thread/34838842/#34840099
https://s1.desu-usergeneratedcontent.xyz/mlp/image/1579/20/1579202665541.png
https://colab.research.google.com/drive/1xnbFP2ygi4u2zY4fl67jY3uXhlu7ntTa
https://colab.research.google.com/drive/1XxO7eug3JMaI44IpVX5Qk3aFUVvyOPFI
https://colab.research.google.com/drive/1qEwv6sHkmjD6GFflDxBXbefHXph2kJJv
https://colab.research.google.com/drive/1p5Y6cqVAd9NTnFqQ7M11i4hG7M0DwvU2


New version of the simplified synthesis script. A modified version of Cookie’s 22KHz

synthesis script. In this notebook most of the code has been hidden away. Has directions

in LARGE FONT.

PPP Inference Server Script: Colab

Provides a web GUI frontend for Colab speech synthesis. (Source: >>35380482)

Glow-TTS Notebooks:

Jaywalnut310/glow-tts Train V1.0.2 22Khz: Colab

Jaywalnut310/glow-tts Synthesis V1.0.2 22Khz: Colab

nVidia TacoTron2/MelGAN Notebooks:

22KHz MelGAN Synthesis Script: Colab

A modified version of Cookie’s 22KHz synthesis script. In this notebook MelGAN is used

instead of WaveGlow to generate speech. Standard 22KHz models should be

compatible. (Source: >>34892762)

Persona Nerd’s 48KHz MelGAN Training Script: Colab

Used to train models with the MelGAN. (Source: >>35346247)

Persona Nerd’s 48KHz MelGAN Multi-Band Training Script: Colab

Used to train models with multi-band MelGAN. (Source: >>35346717)

KanBakayashi/MB-MelGAN Training Script: Colab

Used to train models with multi-band MelGAN. (Source: >>35350036)

ESPNet TacoTron2/ParallelWaveGAN Notebooks (For archival purposes only, do not use):

*ESPNet/Tacotron2 and ParallelWaveGAN guide*

ESPNet TacoTron2 Training Notebook: Colab

Trains a model using ESPNet’s implementation of TacoTron2. By default the notebook is

set up for 22KHz training. Note that ESPNet TacoTron2 models are not compatible with

nVidia TacoTron2 models. (Source: >>35366623)

https://colab.research.google.com/drive/1UjSg4tDcubbkax781fE0pNeAFdht_MZ0?usp=sharing
https://desuarchive.org/mlp/thread/35377182/#35380482
https://colab.research.google.com/drive/1lcviozNz6fc-TrqT8iHsAgjXthKnYUF9?usp=sharing
https://colab.research.google.com/drive/1P5o_mB-u8o3Ol1kMuRoG-bMZ2gEPNTPi?usp=sharing
https://colab.research.google.com/drive/1etnOaSITFK3Hh2MSjHu1S0N4VffpRofK
https://desuarchive.org/mlp/thread/34869617/#34892762
https://colab.research.google.com/drive/1VFxxtu7qt75LC29E1wA5YUqN1n69y-5H?usp=sharing
https://desuarchive.org/mlp/thread/35338697/#35346247
https://colab.research.google.com/drive/1L6gN93GR9OHd5atRmkuBIPRNHrAfXtg6?usp=sharing
https://desuarchive.org/mlp/thread/35338697/#35346717
https://colab.research.google.com/drive/1JgnBMJL_zybYyq1Io7nwGdL1ow7esgPK?usp=sharing
https://desuarchive.org/mlp/thread/35338697/#35350036
https://docs.google.com/document/d/1A1IF-9phqCC1Qc7Y5m7jxlrgzsTSd-_ixNrDHmcKgEg
https://colab.research.google.com/drive/1gPGODo9REPI8TydKAKZfHT6jAwGek8lj?usp=sharing
https://desuarchive.org/mlp/thread/35338697/#35366623


Parallel WaveGAN Training Notebook: Colab

Train a ParallelWaveGAN model for vocoding. Set up for 22KHz training by default

(Source: >>35358323)

ESPNet/ParallelWaveGAN Synthesis notebook: Colab

Synthesis notebook for ESPNet TacoTron2 models and ParallelWaveGAN vocoder

models. The notebook will auto determine the sample rate for the models used.Note that

you will need an equivalent ParallelWaveGAN model for every TacoTron2 model used.

(Source: >>35369476)

22KHz ESPNet/Transformer Training Notebook: Colab

Early/WiP version of the ESPNet TacoTron2 training notebook. (Source: >>35363219

and >>35365186)

FastSpeech2/WaveGlow:

FastSpeech2/WaveGlow Synthesis Notebook: Colab

DeepVoice3 Notebooks:

Original DeepVoice3 Notebook: Colab

First notebook available to the public. Set up for training a Twilight model.

TacoTron2/HiFi-GAN:

Tacotron2 and HiFi-GAN Inference Notebook: Colab

Now with super-resolution.

TensorSpeech/Multi-Band MelGAN-HF:

TensorSpeech/Multi-Band MelGAN-HF training notebook: Colab

CookieTTS (Ngrok Repo) Notebooks:

Custom Ngrok Training Notebook: Colab

Train your own Ngrok model.  Made by BFDIAnon, uses Cookie’s repo.

https://colab.research.google.com/drive/1-bWbQ49FQRdcJ0FK7wh-rn7wYDuuHcHF?usp=sharing
https://desuarchive.org/mlp/thread/35338697/#35358323
https://colab.research.google.com/drive/1MLrg00wQYi2_HCVgiOha29_zEj5xKACp?usp=sharing
https://desuarchive.org/mlp/thread/35338697/#35369476
https://colab.research.google.com/drive/1BTTbztBRb_gjv2zFcKF77YdmQ-oa2p74?usp=sharing
https://desuarchive.org/mlp/thread/35338697/#35363219
https://desuarchive.org/mlp/thread/35338697/#35365186
https://colab.research.google.com/drive/14uX9mlC-9hWPNh8GQoccIyTQe0tgpgj2?usp=sharing
https://colab.research.google.com/drive/17TMYl3anIwegk-sBU6jHngpqo_3sjtW8
https://colab.research.google.com/drive/1dxVcqe4m-AU8NAA1I1MW1N9HYBO_oii_?usp=sharing
https://colab.research.google.com/drive/1RI5pTUIA9e0xENbzskSTd9_wdM6v9x7C?usp=sharing
https://colab.research.google.com/drive/1uvP6cHtDYsgy_0mmlguY_CZrzy6T5e5r?usp=sharing


Custom Ngrok Synthesis Notebook: Colab

Generate a sharable link for a temporary Ngrok server using your custom model.  Made

by BFDIAnon, uses Cookie’s repo.

TalkNet:

Controllable TalkNet (from SortAnon): Colab

Creates audio based on a reference clip. Instructions included inside.

Controllable Talknet Training Script (from SortAnon) Colab

Training script for the Talknet notebook.

Other Notebooks:

Automatic Super Speaker-Filtered Audio Processing (ASSFAP): Colab

A Colab notebook that attempts to automatically clip and transcribe audio files. It uses

IBM’s Cloud Speech service to do this.

https://colab.research.google.com/drive/1pArfzHa_m4RkkvwtbMYshbGxunhzqqh8?usp=sharing
https://colab.research.google.com/drive/1aj6Jk8cpRw7SsN3JSYCv57CrR6s0gYPB?usp=sharing
https://colab.research.google.com/drive/1Nb8TWjUBJIVg7QtIazMl64PAY4-QznzI?usp=sharing
https://colab.research.google.com/drive/18lBRBWOs4uV1DjhoW_fVzoydYUw400PW


Animation
This section details a plan for creating AI-driven animations. It consists of three parts:

1. Replicate available animations using available puppets. After this step, we should be
able to provide an algorithm with (1) a rendered scene from an animation, and (2) some
relevant puppets and resources for characters in the scheme, and the algorithm should
output an animation timeline that matches the rendered scene using only the provided
puppets/resources.

2. Train an AI to generate natural motions corresponding to an action label. After this step,
the AI should be able to take a single pose at the beginning of an animation and an
action label to generate the full animated poses.

3. Generalize the AI to generate motions for all show characters. After this step, the AI
should be able to learn from the motions of one character to generate similar motions for
another character while retaining character-unique attributes.

We need to do a lot of work to get to the point where we can apply animation research to
ponies. We just need to get to that point so we’re basically guaranteed to get animation AI as
researchers continue making progress.

The Current Plan

Replicating available animations
This plan in this section is an OLD suggested flow for creating animation AI. We have much
better data available than we originally anticipated. Most of this plan was based on the
assumption that we would need to recreate character puppets and pose information from
renders. It turns out we have all of that information from show FLA files. As a result, we don’t
need to replicate the available animations. We can just dump the information directly.

Tasks:
1. [In progress] Figure out how to load available assets programmatically.

a. [On Hiatus] Blender Anon is working on this as part of a task to load Flash assets
into Blender.

b. [ ] Assets in FLA files come with references to symbols frames, positioning
information, and transformation information. We’ll need a rendering engine for
this information.

2. [ ] Generate a dataset of animations with known character pose information
a. [ ] Figure out how to reposition and render assets programmatically.
b. [ ] Add posed characters to backgrounds and animations
c.



3. [ ] Get a dataset of animation images that contain characters for which we have
resources available.

a. [ ] Create a dataset of show-style clips from derpibooru. Associate each clip the
the list of characters in it using derpibooru’s tags.

b. [ ] Clips from the show would work too. If we do this, we may need to label each
clip with the list of characters in it to narrow the search space later on.

4. [ ] Find an AI/search algorithm that will try out different assets and try to position them in
a way that most closely matches what’s in each animation image.

a. [ ] Review the relevant research.
i. OpenPose, DeepCut, AlphaPose, Mask RCNN, Awesome Human Pose

Estimation
ii. HRNet, HigherHRNet
iii. Candidate codebases

b. [ ] Train a pose estimation AI on our generated dataset of animations with known
poses

c. [ ] Apply the pose estimation AI to our labeled dataset of animations with known
actions

d. [ ] Output a dataset of asset positioning information for each character and for
each frame in our animation with known actions.

Generating motions associated with an action
Tasks:

1. [In progress] Create a dataset of action commands useful for describing animation clips.
a. [Done] Synthbot has created a tool for identifying the tags we would want to keep

as candidate commands. You can use it to load files from here one at a time.
b. [Done] Clipper is currently using the tool to create a dataset of relevant tags.

2. [ ] Create a dataset of animation clips whose character actions we can recreate using
available puppets.

a. [ ] Once we know the relevant tags, we’ll need a database of images associated
with those tags.

b. [ ] We’ll need to filter the database to retain only images with characters in the
styles for which we have puppets (i.e., show-style).

3. [ ] Create a dataset assigning each animation clip to a command describing what motion
each character is performing.

a. [ ] Once we have the filtered images, we’ll need to run our animation replication
scripts to get character positions for every frame in the filtered clips.

b. [ ] Once we have character-specific animations, we’ll need to create a dataset
associating action labels to each character-specific animation.

4. [ ] Train a neural network to generate a puppet motion sequence given a set of relevant
action labels.

a. [ ] Review the relevant research. This will require a lot of experimentation.

https://medium.com/beyondminds/an-overview-of-human-pose-estimation-with-deep-learning-d49eb656739b
https://medium.com/beyondminds/an-overview-of-human-pose-estimation-with-deep-learning-d49eb656739b
https://towardsdatascience.com/overview-of-human-pose-estimation-neural-networks-hrnet-higherhrnet-architectures-and-faq-1954b2f8b249
https://paperswithcode.com/sota/multi-person-pose-estimation-on-mpii-multi
https://synthbot-image-labeler-sparse.s3.eu-west-2.amazonaws.com/index.html
https://u.smutty.horse/lvzbvnnfwwp.zip
https://github.com/sebastianstarke/AI4Animation


b. [ ] Adapt relevant motion capture-based animation AI to our own puppet
sequence-base animation AI. This will require a lot of experimentation.

Generating natural motions for all show characters
Tasks:

● [ ] Experimental: See if it’s possible to create a character embedding that isolates
character-unique movements.

○ This would be the easiest and most scalable approach, but it’s not clear how
feasible this is. We’ll need to review the research to see where we may be able to
add in a character embedding. We can take advantage of our findings from
speech generation for this problem.

● [ ] On failure: Turn show episodes into short clips and label each clip with the relevant
character actions. Try to create character embeddings using the larger dataset.

● [ ] On failure: Wait for the research to catch up. Maybe make our dataset as easy as
possible for other researchers to use, and try sending out requests for research to
research labs.

Tutorials

Extracting FLA animation data
This guide explains how to extract AI training data from FLA flash animation files.

Setting up the dev environment
You’ll want to do this on a Windows or Mac since that’s what Adobe Animate requires.

● Download and unpack the animation files from
https://drive.google.com/drive/u/7/folders/1gRGJzatBbwyAL459OnlqHE1E_9XQspb_.
This contains all known show animation source files, plus some fandom animations. It’s
about 250GB.

● Install Adobe Animate. Adobe Animate can deal with all of the required file formats, and
it provides a scripting interface for loading, manipulating, and rendering the files.

● Install npm from https://nodejs.org/en/. Either version is fine, but prefer the latest version.
npm is a package manager for Javascript development. Adobe Animate requires code in
an ancient version of Javascript. We can use various packages to write code in a newer
version of Javascript, then “compile” (transpile) it down to the version that Adobe
Animate requires.

● Install git. This is required for installing Babel, which we use to transpile modern
Javascript code into the ancient version Adobe Animate requires. There’s probably a
way around installing git for this, but I haven’t tried looking for one.

● Clone the synthanim git repository from https://github.com/synthbot-anon/synthanim.
This repo contains configuration files for telling Babel how to transpile the code properly

https://drive.google.com/drive/u/7/folders/1gRGJzatBbwyAL459OnlqHE1E_9XQspb_
https://nodejs.org/en/
https://github.com/synthbot-anon/synthanim


and for telling Webpack how to build the code into JSFL files. After cloning the
repository, make sure to edit line 1 of webpack.config.js to match your Adobe Animate
setup. The “Getting Started: Hello JSFL” section explains how to do this.

Why Adobe Animate?
FLA files are somewhat complicated. There are multiple versions, and MLP was developed over
a long-enough period that it uses multiple versions. Adobe Animate was designed for creating
and modifying flash files. It can handle all of the complexity involved with the file format, and it
provides a consistent interface for the different FLA versions. Adobe Animate also provides a
scripting interface that lets us take advantage of whatever the UI can do. It lets us do things like
select a single character within a file and animate just that.

Getting started: Hello JSFL
This is an introductory section showing you how JSFL works. It doesn’t use any of the
Javascript development tools in your dev environment.

Adobe Animate lets you run ECMAScript 5 plugin scripts, which is an ancient version of
JavaScript. These plugins will have the JSFL file extensions. You can get started with a Hello
JSFL plugin as follows:

● Open any of our FLA files in Adobe Animate.
● Create a new JSFL file. File -> New. Scroll down to select JSFL Script File and select

that. On the right panel, enter the script name "HelloJSFL".
● In the new HelloJSFL.jsfl file tab, type fl.trace("Hello JSFL"); and save the file.
● Switch to the FLA file tab. Run Commands -> HelloJSFL. You should see a new Output

panel on the bottom containing the text "Hello JSFL".

You can find partial documentation on APIs that Adobe Animate supports here:
● https://www.adobe.io/apis/creativecloud/animate/docs.html

When you created the JSFL script, Adobe Animate placed it in a particular folder. You can see
which folder by hovering over the HelloJSFL tab. It should be something like this:

● C:\Users\...\AppData\Local\Adobe\Animate 2020\en_US\Configuration\Commands

That path is important. Any JSFL files placed in that directory will automatically get detected by
Adobe Animate. When we build our code, we’ll place the build outputs in that directory. If you
want to use the tools in the synthanim repository for development, edit line 1 of your
webpack.config.js file to match this path.

Some things to note:
● Adobe Animate's JSFL API documentation is not that good. We'll need to use

undocumented APIs to get access to documented objects, and the object hierarchies
aren't documented well. There’s enough exposed that we can get whatever data we

https://www.adobe.io/apis/creativecloud/animate/docs.html


need. We'll need to pool together API information as we run into it. Post what you find in
the thread.

● There are APIs for loading and closing FLA files, which will be useful for batch
processing. Unfortunately, Adobe Animate pops up a confirmation box whenever you
load an old FLA file. We don't know how to disable this popup. We may need to use an
autoclicker to get past this when working with hundreds or thousands or files.

● Your HelloJSFL script needs to be written in ECMAScript 5. ECMAScript 5 is a pain in
the ass, in part because it has a ton of gotchas that make programming difficult, and in
part because it's missing features that people use frequently in code examples. We’re
going to use Babel to transpile ECMASCript 2020 to ECMAScript 5.

Using the dev environment
This section assumes you have gone through previous sections to set up synthanim. That
means:

● You’ve downloaded the synthanim git repository.
● You’ve install npm.
● You’ve configured webpack.config.js with Adobe Animate’s Commands directory. If you

don’t want to do this, you can comment out line 1 in webpack.config.js and uncomment
line 2. Uncommenting line 2 will tell webpack to write the build files to the
synthanim/dist/ directory.

To finish setting up synthanim, navigate to the synthanim folder in a PowerShell or Bash
Terminal.

● cd synthanim

And run the following command to install all necessary dev packages:
● npm install # installs the list of packages in package.json

To build the JavaScript files into Adobe Animate commands, run:
● npm run build # build JavaScript files into an Adobe Animate command

To monitor JavaScript files for changes and automatically rebuild them, run:
● npm run watch # monitor src/ folder and rebuild automatically

Patching Adobe Animate (optional)
You only need to do this if you want to run scripts on our FLA files in batch. If you’re fine running

it on the FLA files one at a time, this is unnecessary. In total, Animate needs the following

patches:

1. Remove the free trial limitation.



2. Remove the popup when loading files that contain ActionScript 2.0 code.

3. Remove the popup when trying to export an image that’s too large.

4. Remove the popup asking the user how to handle JSFL files opened from the command

prompt.

5. Remove the popup when converting an FLA file to XFL.

6. Remove the popup when Animate is unable to open a file.

7. Remove the popup when Animate is missing a font required by a file.

Option 1 - Download the patched Adobe Animate 21.0.5.

● Download link:

https://drive.google.com/drive/folders/17hgz4fbIqYetvxHh2MX1KdTP6efIauUU?usp=shar

ing

● Unpack the zip file (password: iwtcird) and run Animate.exe.

Option 2 - Manually apply the patches.

You’ll need a hex editor.

● HxD: https://mh-nexus.de/en/hxd/. This is a hex editor. If you’re using the short version,

you’ll use this to edit hex files. If you’re using the long version, this is a convenient way to

get a hex pattern for a string in Animate.exe.

Diff the uncompressed “Animate.exe” file with the “Animate - original.exe” file to get a list of

patches that need to be applied. Apply the patches to your own version of Animate.exe.

- For Adobe Animate 21.0.5, you can download both the patched Animate.exe and the

original Animate.exe here:

https://drive.google.com/drive/folders/17hgz4fbIqYetvxHh2MX1KdTP6efIauUU?usp=shar

ing

- For other versions of Adobe Animate, ask in the thread.

Option 3 - Generate the patches.

If you’re going to do this, mention it in the thread and ask for help if you get stuck. This section

will walk you through the process of running a debugger to get rid of an alert in Adobe Animate.

You’ll need to install x64dbg in addition to HxD:

● x64dbg: https://x64dbg.com/#start. This is a debugger.

https://drive.google.com/drive/folders/17hgz4fbIqYetvxHh2MX1KdTP6efIauUU?usp=sharing
https://drive.google.com/drive/folders/17hgz4fbIqYetvxHh2MX1KdTP6efIauUU?usp=sharing
https://mh-nexus.de/en/hxd/
https://drive.google.com/drive/folders/17hgz4fbIqYetvxHh2MX1KdTP6efIauUU?usp=sharing
https://drive.google.com/drive/folders/17hgz4fbIqYetvxHh2MX1KdTP6efIauUU?usp=sharing
https://x64dbg.com/#start


First, you’ll need to attach the x64dbg debugger to Animate.exe. To do that…

● Install x64dbg and run it as Administrator. (Right click, Run As Administrator)

● When it opens, the first thing you should do is go to Options -> Preferences and uncheck

everything.

● Then go to File -> Open and run Animate.exe from your Program Files directory. Always

look at the bottom left corner to see if it says Paused, the debugger pauses a lot from the

many exceptions that appear. Whenever the debugger pauses, you can resume

execution by clicking Run (blue arrow icon).

All of the default exceptions are useless. You can get rid of them as follows:

● To get rid of the breakpoints, click on the Breakpoints tab and delete everything there.

● To get rid of other exceptions as they come up, whenever an exception appears, go to

Options -> Preferences -> Exceptions and click Add Last. This will prevent that exception

from coming up again.

Keep adding exceptions to your ignore list and clicking Run until it stops doing that. At this point,

you should be able to load an FLA file into Adobe Animate.

Now we’ll want to make sure that the popup code is loaded into memory. Pick any file that

causes the unwanted popup. Keep clicking through Run and adding exceptions until it loads,

then close the file. Again, keep clicking through Run and adding exceptions until you’re on the

screen where you can load a file again.

Now we’ll need to add a breakpoint to pause Adobe Animate when we’re in the function that

calls the popup. To do that…

● Open up Adobe Animate in HxD and search for the string "is no longer supported in this

version". You’ll see the string on the right-hand side and the corresponding hex in the

left-hand side. Copy the hex string for the entire paragraph.

● Go to the Memory Maps tab in x64dbg. Right click anywhere and select Find Pattern.

Paste the HxD pattern in. Double-click through each result until I find the one that

matches the "ActionScript @0" string you see in HxD. You should only see one result,

but if you see multiple then you can follow the next step to set a breakpoint for each one.



● The memory location should be highlighted in the bottom pane of x64dbg. Right-click

any line of the pattern in the bottom pane, then select Breakpoint -> Hardware -> Access

-> Word. This will pause Adobe Animate whenever it tries to access this string.

● Open any file that causes the popup. Now x64dbg will break on whatever function is

using the "ActionScript @0 is no longer supported" string.

Now open the Call Stack tab in x64dbg. We’ll need to figure out which function in the call stack

is the one that shows the popup.

● Double-click through each of the lines that says "animate" in the Comment column. This

will bring you to the “return” location of that call, which is one instruction below the actual

call.

● The first few are all doing some basic string operations, so ignore those. You can ignore

all of the ones that use "memcpy" or string-anything in the same function.

● The first one that's not doing a string operation is the one to delete. When you open that

function, x64dbg will highlight the first instruction after the call we want to delete. So

scroll up by one instruction to find the call we’re going to delete.

Once you’ve highlighted the call you’re going to delete, you can delete the call like this:

● Make sure the call instruction is highlighted.

● Press space to get the assemble window.

● Put “nop” in the box

● Make sure Fill with NOP's is checked, or you'll only create one nop and the rest of the

leftover call code will cause Animate to hang.

● Confirm, then close the box.

It’s patched. Now test it opening another ActionScript 2.0 file. If everything worked, the dialog

box shouldn't appear when you open it.

Repeat the process for the case where a bitmap is too large to export:

● HxD string to search: “The bitmap is too large. The largest bitmap that can be created is”

● File to open:

https://drive.google.com/file/d/1sJqHDYQfjVyblxZkTIDZ4HdN0iDZ9DBb/view?usp=shari

ng

https://drive.google.com/file/d/1sJqHDYQfjVyblxZkTIDZ4HdN0iDZ9DBb/view?usp=sharing
https://drive.google.com/file/d/1sJqHDYQfjVyblxZkTIDZ4HdN0iDZ9DBb/view?usp=sharing


● You can trigger the popup by running the AnimationExtractor JSFL script on the file.

● The relevant function in the call stack makes a reference to “BitBuffer”. Once again, after

double-clicking the relevant call in the call stack, go up 1 instruction and replace the call

at that location with NOP.

Repeat the process for the case where a file cannot be loaded:

● HxD string to search: “An error occurred opening file”

● File to open:

https://drive.google.com/file/d/1_xAfAOX9bsS6oEYIcLwmNY6p6FY5FVE7/view?usp=sh

aring

● You can trigger the popup by opening the file.

● The relevant function in the call stack has a call further below to “BCString” something.

There’s a call to “animate.something” between the BCString call and a basic_something

call. Replace that call at that location with NOP.

The process is similar for all of these files:

● https://drive.google.com/drive/folders/1xW1oCWmM8Kqwd6-my_neImGwpGuPm98-

Save the patch by pressing Ctrl + P and clicking Patch File. Name it Animate.exe and save it on

your desktop or something. Rename your original Animate.exe something else and move the

modified Animate.exe to your Adobe folder. You don't want to overwrite the original, keep it as a

backup.

The file you just saved is the patched version of Animate.exe.

Progress

Derpi Tag Dataset
This task is complete. You can download the results here:

● https://drive.google.com/file/d/11ZUkUc7q3jSYOpbkve3JgdnaGXLOzLVG/view?usp=sha
ring

We’re using images from Derpibooru to bootstrap our animation dataset. The completed
animation AI will let anons direct pony animations using action commands, similar to emotes in

https://drive.google.com/file/d/1_xAfAOX9bsS6oEYIcLwmNY6p6FY5FVE7/view?usp=sharing
https://drive.google.com/file/d/1_xAfAOX9bsS6oEYIcLwmNY6p6FY5FVE7/view?usp=sharing
https://drive.google.com/drive/folders/1xW1oCWmM8Kqwd6-my_neImGwpGuPm98-
https://drive.google.com/file/d/11ZUkUc7q3jSYOpbkve3JgdnaGXLOzLVG/view?usp=sharing
https://drive.google.com/file/d/11ZUkUc7q3jSYOpbkve3JgdnaGXLOzLVG/view?usp=sharing


video games. The set of actions ponies can perform is very complex, and we can’t manually
specify all of them. We’re using Derpibooru labels as a starting point to find relevant actions.

The problem is that Derpibooru labels are very noisy, and they cover a lot more than what we
need. There are about 25,000 candidate tags associated with animated images in Derpibooru,
most of them useless for our purposes. We need help identifying the tags that are useful for
describing character puppet movements.

Synthbot has created a tool for labeling tags, which you can find here:
● https://synthbot-image-labeler-sparse.s3.eu-west-2.amazonaws.com/index.html

To use this, you’ll need to upload an image list. You can find the Derpibooru image lists here:
● https://u.smutty.horse/lvzbvnnfwwp.zip

UI controls:
● Left click on an image to toggle between “Keep tag” and “Reject tag”. You can

single-click to immediately accept a tag that has not yet been selected, and you can
double-click to immediately reject a tag that has not yet been selected.

● If a tag seems like it might be useful but a particular image has quirks to make it not
useful, you can select “Reject image”.

● Middle-click an image to view other animated images with the same tag in Derpibooru.
● Don’t worry about whether an image is show quality. The goal is only to label the tags as

“good for describing the character’s motion” or “not good for describing the character’s
motion”.

● Prefer to err on the side of keeping tags. It will be much easier to remove extra tags than
it will be to add in missing tags.

● The “Hide Completed” button will clear the page of any completed images. They’ll still be
exported normally, so you don’t have to worry about losing your labels. The button is
there to help you quickly see any images that you might have missed.

● Make sure you export your data before loading a new image list. Every time you load a
new image list, your previous labels are forgotten.

Clipper has labeled most of our 23,000+ tags, and he should be done with the rest soon.

https://synthbot-image-labeler-sparse.s3.eu-west-2.amazonaws.com/index.html
https://u.smutty.horse/lvzbvnnfwwp.zip


Image Generation
At this time this is really early on and we are still figuring things out.

Tutorials

Scraping Images

Right now there are two scraping scripts available for gathering metadata:

Clipper’s script

Anon’s script

Anon’s script URL only

Anon’s Script
Download one of the scripts here:

Anon’s script

Anon’s script URL only

The full script will record the image ID, the tags, the score, and the location of the full resolution

image. The URL only version will only record the image locations.

There are 5 configuration options:

booru: This sets what site will be used for scraping. By default it is set to PonerPics.

searchTerm: This sets what search term will be scraped from the booru. The easiest way to

generate this is to do a regular search on the booru and copy the string from the URL bar. Do

not copy sort parameters. See example below:

https://pastebin.com/uXXcEHKF
https://pastebin.com/t1XvZSRG
https://pastebin.com/ujc2UfdV
https://pastebin.com/t1XvZSRG
https://pastebin.com/ujc2UfdV


filter: Sets what filter will be used when searching. By default it is set to PonerPics’s everything

filter.

pageDelay: Allows you to wait a set amount of time between making requests to the booru.

Enter the time here in seconds. Note that this will slow down scraping.

saveLocation: Sets what txt file you want the scraping results saved to.

Clipper’s Script
TBD.

Tagging Images

Anon’s Plot Tagger
Download

TBD.

Tagpls

TBD.

Progress

List of Colab Scripts

StyleGAN2 Training and Synthesis Script: Colab

Use AI to create pony images. (Source: >>35339733)

https://mega.nz/folder/sSZxGagR#nIhHwcrjrBjePgReiggTeQ
https://colab.research.google.com/github/wow-glimmer/stylegan2_scripts/blob/master/public_StyleGAN2_Colab_Train.ipynb


BigGAN/CLIP: Colab

Uses AI to generate images according to a textual prompt.

Finding Pony Neurons in CLIP: Colab

Dall-E notebook: Colab

Create images from text.

Deep Daze notebook: Colab

Create images from text.

https://colab.research.google.com/drive/1NCceX2mbiKOSlAd_o7IU7nA9UskKN5WR?usp=sharing#scrollTo=Nq0wA-wc-P-s
https://colab.research.google.com/drive/1HVJazTPdTiV1xHXiM7Lypm6R9nIBrHYc
https://colab.research.google.com/drive/1xYW-eSmlueBll1mMdE5wpT25cPVYtT5H?usp=sharing
https://colab.research.google.com/drive/1FoHdqoqKntliaQKnMoNs3yn5EALqWtvP?usp=sharing#scrollTo=-irecVJr_Zc9


Other

List of Colab Scripts

Talk to /mlp/: Colab

From the notebook: This is a Colab notebook with a GPT-2 text generating model trained

on a 100MB worth of a dump of /mlp/'s posts from its inception to June 2019.

GPT-J-6B PNY: Colab (Guide)

This notebook allows you to generate text using a finetuned version of the 6B parameter

GPT-J model from EleutherAI

ESRGAN Notebook: Colab

Image super resolution similar to Waifu2x.

DeepDanbooru notebook: Colab

Uses AI to automatically tag images. Includes dataset scraper, training script, and

synthesis script.

Interacting with Jukebox: Colab

AI music generation?

https://colab.research.google.com/drive/1MuhbJsPC1Z0OBO9NJxO8bhRVpG2-YH45?usp=sharing#scrollTo=rRd4nPSelkBa
https://colab.research.google.com/drive/13R8MJEDTwinEmUJMLqydKOIcAvWiBIlT?usp=sharing
https://docs.google.com/document/d/1hplZl-nSNgM6H6QD1pE2WLehPWNz1Ei8oQLOV0giIrQ/edit?usp=sharing
https://colab.research.google.com/github/dvschultz/ESRGAN/blob/master/ESRGAN.ipynb
https://colab.research.google.com/drive/1mPzBzPCM4ULLixlmyQVBiAORVjJDg5Gm?usp=sharing
https://colab.research.google.com/github/openai/jukebox/blob/master/jukebox/Interacting_with_Jukebox.ipynb?fbclid=IwAR3HnJCaWFvaxJF6cDaL4S8BOPEP-nz5Jhj_9cw7OrRZxn1kD6hPkdCsFKk&authuser=1#scrollTo=-sY9aGHcZP-u


Submitting Your Content
We do not have an official solution for sharing contributions at this point. For the time being, put

your files (audio, text transcriptions, modified Audacity labels, etc) in a Zip archive, upload it,

and post a link in the thread. Explain what it is you’re uploading, and make sure that the files are

sorted into folders by season and episode (or by source if not from the show).

If you’re uploading cleaned audio from a noisy clip that you made, upload both versions of the

clip. We will be archiving both the original and a cleaned version so that anons can create their

own cleaned versions if they feel they can do better.

Some suggested file hosts:

https://smutty.horse

https://zippyshare.com

https://nofile.io

https://anonfile.com

https://mega.co.nz

https://dropbox.com

https://drive.google.com

https://smutty.horse
https://zippyshare.com
https://nofile.io
https://anonfile.com
https://mega.co.nz
https://dropbox.com
https://drive.google.com


Our Plan (WIP) (crashing this plane)
Machine learning works as the name implies: you create a program (often a neural network) that

can learn from information you give it and “teach” it what outputs it should return for a given

input. There are already a large number of open source machine learning projects available to

use as a foundation, including several specifically designed for what we are trying to do (e.g.

Google’s Tacotron). This Anon explains it in more detail:

A project such as Tacotron could be used to produce a proof of concept, but first we need a LOT

of audio to work with. Dialog has already been extracted from MLP:FIM seasons one through

eight in the highest quality available. There is a torrent available for this in the “Resources”

section of this guide.

https://google.github.io/tacotron/
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Tools
● Audacity, for clipping audio

● Praat, for annotating audio clips with timed transcriptions and ToBI events

● iZotope RX7, for noise removal

○ ISSE is a possible free alternative

○ iZotope RX is not free. However (and I definitely don’t endorse this), cracks do

exist. I won’t provide you a link because we want to stay under the radar. Just

avoid R2R and CracksNow, they have been known to include ransomware.

● Anon’s SRT to Audacity App , for converting SRT subtitle files to Audacity labels

● 14aren, a nice file renaming tool for Windows (for after-the-fact naming adjustments)

● mlp_dialog_rip.sh, the shell script used to extract dialog and subtitles from S01-S08. It

applies the process described by this page using the ffmpeg utility

● Tacotron Text Transcription Tool, for easily transcribing datasets into something usable

by Fifteen.AI or the Google Colab notebooks. Check out a visual demonstration here of

how to use it. Hotkeys are End to play audio, Page Up to go back a line, Page Down to

go to the next line. Ctrl+S to save. Progress is saved on a line every time you switch

what file you're transcribing. Source code is available here.

● Google Speech-To-Text -> Dataset Processor Spits out a dataset.txt formatted correctly

for the system. Needs a Google Cloud SDK installation to function. This shit costs

money to use after the first $300, so make sure to let google data harvest you with

Data Logging to reduce that overhead. However, it’s generally pretty accurate. Use

this if you’ve got a gigantic pile of speech from, say, a video game, and no transcription

available. Works better with longer sentences.

● Anon’s Audacity Label Timestamp Script, a PowerShell script to add timestamps to an

existing set of Audacity labels

● Anon's Character Tagger, an attempt to automatically tag characters in an Audacity label

file by comparing it to transcripts available on the mlp wiki. Due to differences in spelling

and abbreviation between transcripts and subtitles, will not be able to tag all lines but

should be able to do most.

● Notepad++, a programmer’s text editor for Windows, for manually editing Audacity label

files

https://www.audacityteam.org/
http://www.fon.hum.uva.nl/praat/
https://en.wikipedia.org/wiki/ToBI
https://www.izotope.com/en/products/repair-and-edit/rx.html
http://isse.sourceforge.net/
https://www.scirra.com/arcade/other-games/srt-to-audacity-39655
https://www.1-4a.com/rename/download.htm
https://pastebin.com/LdApDEZh
http://www.mlptf2mods.com/tutorials/resource-materials/
https://file.house/U8iZ.zip
https://file.house/jZ3R.mp4
https://file.house/jZ3R.mp4
https://github.com/Iamgoofball/tacotron-transcription-tool
https://gist.github.com/Iamgoofball/e65653302c4466a470a391855c5e6967
https://pastebin.com/M6t5rEdG
https://www.scirra.com/arcade/other-games/character-tagger-39742
https://notepad-plus-plus.org/


● Anon’s Transcript Generator, a Python script for generating transcript text files

(instructions available at 33:25 in this demo video)

● Anon’s Checking Script, a Python script that checks for common formatting errors in

label files and automatically replaces shorthand character, emotion and noise tags with

their full versions.

● Twibot’s Working Demo, A functional demo of our current progress

● Pony Sorter, A program  to sort the different clip versions

● Twibot’s Audio Project Utilities, used to extract audio from the dataset

● Cookie’s Custom Processing Script

● Synthbot’s Tools

● TKinterAnon’s GUI Synthesis (local synthesis):

○ Note: version 1.1 is an easier setup than 2.0, may just want to use 1.1 if only

interested in colab voices.

○ Version 2.0 full (>>35283074)

○ Version 2.0 15 only (>>35283074)

○ 1.1 Patch

○ Version 1.0 (>>35069149)

● ARPAbet Converter

● Audacity2Transcript, Turns exported audacity labels into Tacotron2 text

● 22KHz to False 48KHz Tutorial, helps the quality of 22KHz models

● DeltaVox, a 15.ai client

● Synthbot’s Patched Animate, anon- and automation-friendly for working with FLA files

https://pastebin.com/1Y1qz4EC
https://www.python.org/
https://youtu.be/KmpXyBbOObM
https://pastebin.com/2B2skWsv
https://www.python.org/
https://pastebin.com/S5pejVnU
https://github.com/SortAnon/PonySorter
https://github.com/Twibot-ai/audio_proj_utils
https://pastebin.com/zueesbwR
https://github.com/synthbot-anon/synthbot
https://drive.google.com/open?id=1DeSCjCLrrHN69s11YmCq42rkMat-m6SL
https://drive.google.com/open?id=1utquUSf1g9iPVqe2RxVzoIQHeRbbtmKt
https://mega.nz/#!3qJlCSCL!sSKPSKgySuMbfwFYBWZMoWgo9IAimDkRGYHv3l1s_Ec
https://mega.nz/#!jnJ1VIyZ!TUGT7-P9avnsGmGFCDDRYE0G8AU4PMMUAjQ9_uiH5Ak
https://github.com/AmoArt/ARPAbet-dialogue-converter
https://github.com/AmoArt/Audacity2Transcript
https://www.youtube.com/watch?v=AZzF8VD6wGM&feature=youtu.be
https://mega.nz/#!HYohWboZ!Ee0Wvd3Ty4GV0Giq2PXu81jt_3ums5-kgPgryLRr_rw
https://drive.google.com/drive/folders/17hgz4fbIqYetvxHh2MX1KdTP6efIauUU?usp=sharing


● Colab script to convert audio sampling rates

● Colab sample script to access derpibooru image and tag data

Resources
IF YOU USE ANY OF THE TORRENT FILES PLEASE LEAVE THEM SEEDING FOR OTHER ANONS

Alternate subtitle source if things don’t seem right (Stange doubling):

https://www.addic7ed.com/

Anon’s In-Depth Mane 6 Vocal Profiles:

https://drive.google.com/drive/folders/12wXl80FDHpJTXSE5Sw5fF_6Fm0GxtC6V?usp=sharing

(Old) Project Logo Photoshop File:

https://files.catbox.moe/j50wq1.psd

iZotope Software:

https://mega.nz/#F!ejJmAChZ!wdgeVS1cGKp0DPgHXU7kgQ

Old Doc:

https://docs.google.com/document/d/11vmRdCFnl_XgKB2XwB82nBAdmC0hfoldzlAeiPB06SM/

edit

Old Contribution Spreadsheet:

https://docs.google.com/spreadsheets/d/15UPAhWr8afJIBk6QWMrjUhI4ZT8enMws9A0u9KBCV

uU/edit#gid=237082183

Open Unmix Audio:

https://mega.nz/#F!swgmBA6b!mCmJ3jt8SKD4NnVvampNpg

Phonetics Guide:

https://docs.google.com/document/d/1gr4HluP9c38Qep1Q2P_OAsW9XmFcK2WRF3Ki4ep2S_

g/edit

https://colab.research.google.com/drive/1DSOvN32LR1cpqjKXx7RuxrH6t7umzJZy#scrollTo=ZBONk45nl4QL
https://colab.research.google.com/drive/1qH2mNOrwCEKBaym8Q7R-D7y9kE1nEsS4?usp=sharing
https://www.addic7ed.com/
https://drive.google.com/drive/folders/12wXl80FDHpJTXSE5Sw5fF_6Fm0GxtC6V?usp=sharing
https://files.catbox.moe/j50wq1.psd
https://mega.nz/#F!ejJmAChZ!wdgeVS1cGKp0DPgHXU7kgQ
https://docs.google.com/document/d/11vmRdCFnl_XgKB2XwB82nBAdmC0hfoldzlAeiPB06SM/edit
https://docs.google.com/document/d/11vmRdCFnl_XgKB2XwB82nBAdmC0hfoldzlAeiPB06SM/edit
https://docs.google.com/spreadsheets/d/15UPAhWr8afJIBk6QWMrjUhI4ZT8enMws9A0u9KBCVuU/edit#gid=237082183
https://docs.google.com/spreadsheets/d/15UPAhWr8afJIBk6QWMrjUhI4ZT8enMws9A0u9KBCVuU/edit#gid=237082183
https://mega.nz/#F!swgmBA6b!mCmJ3jt8SKD4NnVvampNpg
https://docs.google.com/document/d/1gr4HluP9c38Qep1Q2P_OAsW9XmFcK2WRF3Ki4ep2S_g/edit
https://docs.google.com/document/d/1gr4HluP9c38Qep1Q2P_OAsW9XmFcK2WRF3Ki4ep2S_g/edit


Con Doc 2020:

https://docs.google.com/document/d/1QIwzaJBDrYXEBozzgKPfMphmKsYiFVJLhwJTiAeJ1WA/

edit

MLP

MLP:FIM Ripped Dialog S1-S8:

https://files.catbox.moe/2q4p2z.torrent

Netflix Audio:

Season 1 (01-24): Mega

Season 1 (25-26): Mega

Season 2 (01-11): Mega

Season 2 (12-14): Mega

Season 2 (25-26): Mega

Season 3 (01-12): Mega Torrent

Season 3 (13-13): Mega Torrent

Season 4 (01-11): Mega

Season 4 (12-26): Mega

Season 5 (01-26): Mega Torrent

Season 6 (01-19): Mega Torrent

Season 6 (20-26): Mega Torrent

Season 7 (01-26): Mega

Season 8 (01-26): Mega Torrent

Best Gift Ever: Mega

Short - Happy Birthday to You: Mega Anonfile

iTunes Audio:

Season 9 (01-26): Mega

Amazon Audio:

Season 1-2: HTTP

https://docs.google.com/document/d/1QIwzaJBDrYXEBozzgKPfMphmKsYiFVJLhwJTiAeJ1WA/edit
https://docs.google.com/document/d/1QIwzaJBDrYXEBozzgKPfMphmKsYiFVJLhwJTiAeJ1WA/edit
https://files.catbox.moe/2q4p2z.torrent
https://mega.nz/folder/DtUEnJqD#1jP76M2G_0Xqhpwqf1oS1g
https://mega.nz/folder/pt8jFaDA#gF1P1nzuFhVan49r6jOBig
https://mega.nz/folder/w98DnSSY#TRWFGTC2IvcBf8cLltH7CQ
https://mega.nz/folder/kNxmVayI#0_0-3d9gyV80HfvdacCyaQ
https://mega.nz/folder/TlsgGYCZ#5mnF3joaHwFcWBxnH4KcAQ
https://mega.nz/folder/LgsAgYqY#cB4VgoTYVtjKgstwHSOzEg
https://rarbg2018.org/torrent/7iz2nyw
https://mega.nz/folder/eN8wECSJ#zkbLT5cDeCk9gnCYnQGJyw
https://rarbg2018.org/torrent/7iz2nyw
https://mega.nz/folder/WMtngAwY#R5ymbgl7CCsm_UYNTEx5CA
https://mega.nz/folder/zt8C3L7Y#9zgzDALwrvXfgTlCAvCO6w
https://mega.nz/folder/ZRAm3JTT#zEPNWntqO06kLhlPxyKtrA
https://rarbg2018.org/torrent/e2kvr3f
https://mega.nz/folder/hBJClTIL#6uvLPdspahF9lAbhEsit4w
https://rarbg2018.org/torrent/hj63unr
https://mega.nz/folder/LtYhza5R#rxvVLmz52raFJACD6f9BZQ
https://rarbg2018.org/torrent/hj63unr
https://mega.nz/folder/C8IlTAKA#IIPKb4qkr0hrqs6EOUJNvA
https://mega.nz/folder/XgBzhapD#NpGUFO2y_6wbwVqaqkG-Tg
https://rarbg2018.org/torrent/utoqs46
https://mega.nz/folder/T0ZDxQYD#5m3Wt-Gy3Csb5VJaUqFlAQ
https://mega.nz/#!oNEACYQD!dT7lujzDyVWJivqFewaOYK2fHU5xURlqDdbYnDsHmR4
https://anonfile.com/P7weW8z2n2/MLP_Happy_Birthday_to_You_flac
https://mega.nz/folder/bxJD2IqZ#6hQw22hC4vzD2xF2x4gP9Q
http://mlpeps.com/mlp/testfiles/amzn%20webrips/


MLP Movie:

Movie: Mega

MLP Movie BluRay Extras:

Baking with Pinkie Pie: Mega Anonfile

Deleted Scene: Mega Anonfile

EQG Short - Road Trippin’: Mega Anonfile

Making Magic with the Main 6 and Their New Friends: Mega Anonfile

The Journey Beyond Equestria: Mega Anonfile

EQG

EQG BluRay Audio:

EQG (Processed): Mega Anonfile

EQG Extras: Mega Anonfile

EQG Rainbow Rocks (Processed): Mega Anonfile

EQG Rainbow Rocks Shorts: Mega

EQG Friendship Games (Processed): Mega Anonfile

EQG Friendship Games Deleted Scenes: Mega Anonfile

EQG Friendship Games Shorts: Mega

EQG Legends of the Everfree (Processed): Mega Anonfile

EQG Legends of the Everfree Extras: Mega Anonfile

EQG Legends of the Everfree Bloopers: Mega Anonfile

EQG Netflix audio:

EQG: Mega

EQG Tales of Canterlot High: Mega Anonfile

EQG Roller Coaster of Friendship: Mega Anonfile

EQG Rainbow Rocks: Mega

EQG Forgotten Friendship: Mega

EQG Friendship Games: Mega

EQG Legend of the Everfree: Mega

https://mega.nz/folder/ykZBGYzK#W-6ooVntDnb0xCmHJtkn2w
https://mega.nz/#!1cU0QSgD!mTgy-tnGlT5TGQDgEeM2sDAQM5aSen01Pd9qzQylBrI
https://anonfile.com/I7q6t605nc/Baking_with_Pinkie_Pie_RAW_flac
https://mega.nz/#!QIEkgCJJ!VoO75le0dgWyBbQjlIIGRVnbdDVNfPmY4Koud8u0tEE
https://anonfile.com/seq9t606n7/Deleted_Scene_RAW_flac
https://mega.nz/#!5IdiHSjR!Ef4TZCfpJBhKeG2VKFfDkjNG11kQNCZpXkIeaWtFzQE
https://anonfile.com/H1q7t20an1/EQG_Short_-_Road_Trippin_RAW_flac
https://mega.nz/#!xNNCkCYB!KVuxRfjDlziUjd5It_iP2T0VlVFmdM6CRe7zAVCf9Dg
https://anonfile.com/Q4rat70cnc/Making_Magic_with_the_Mane_6_and_Their_New_Friends_RAW_flac
https://mega.nz/#!ccdxlabB!JCgvN2Kmn-niLfZUxcqKNiGku214mLtJciZo6OXAgts
https://anonfile.com/9crdtd0an4/The_Journey_Beyond_Equestria_RAW_flac
https://mega.nz/#!URNlSQzD!vdz787jjNONsw5rYmCWZNrAK6SzsTgtwSXHrYDo525c
https://anonfile.com/FdJ3obz5n3/EQG_Processed_flac
https://mega.nz/#!5NNiDARL!4XiT_Z0corVFRtRaJFIjInw5sIKfkKSzVCxVv4G5pFc
https://anonfile.com/idJ9o5zanf/EQG_Extras_RAW_7z
https://mega.nz/#!VcRF0KhS!jG6Zy3ntFGCMb4ou0Td5YLzmDC-1S1wIBqA1Nz2WPmU
https://anonfile.com/i1K1o8zbnd/EQG_RR_Processed_flac
https://mega.nz/#F!ye5Q3AqY!Mh7Ofpq9pXcToTCwCgpRiw
https://mega.nz/#!MBMn1Q7D!DXhjNQM1wwKc-MEV9mX62HYsiEJE8HtPXXba6QmZ6Xg
https://anonfile.com/Sbt5paz1n2/EQG_FG_Processed_flac
https://mega.nz/#!UZMiTQza!bXt4HEQTQgqz_Qoxaj26ACxrRoHuxyqFxmDQbPa8OyU
https://anonfile.com/Mfq6p5z0nf/EQG_FG_Deleted_Scenes_RAW_flac
https://mega.nz/#F!vboW0AxD!_QWTMQcztBcW09CxkhOkvQ
https://mega.nz/#!scIxySBJ!MXxXBV-X7QmeXFYXZS9iXyb1vnJ484uD3ZcwsCrU55U
https://anonfile.com/jex0W9z5nf/EQG_LoE_Processed_flac
https://mega.nz/#!gMAVAAIB!dlu4u7LMH7nxNz2bj94ZIiBtlBvzs9gzyoggPjhyKYM
https://anonfile.com/nfl0Wbz3n0/EQG_LoE_Extra_Processed_flac
https://mega.nz/#!BFVmxC6Y!1fOTWr71kCNMc8tZtzPjQKziG1XSVYWX8dT1MjAwGZQ
https://anonfile.com/B4G5o7z4ne/EQG_LoE_Bloopers_Processed_flac
https://mega.nz/#F!qLog1C4A!_kRxXKmrR6L7-bhopLzm0A
https://mega.nz/#F!6OwHWADR!gxDzApDA9dNOQj45Fijs0Q
https://anonfile.com/fc39a533n0/EQG_Tales_of_Canterlot_High_7z
https://mega.nz/#F!rLhFCYhb!JQjzZm9sIjHb56AaxBnkDQ
https://anonfile.com/rek1a731n5/EQG_Rollercoaster_of_Friendship_7z
https://mega.nz/#F!3a4BEKpY!JbN_ZfIQpuWwzgjBZ2PdHw
https://mega.nz/#F!mD40hA4Q!7zVDWQ-TubSgqRg8VdpaAQ
https://mega.nz/#F!dMJxQKRa!YrH59Tg_kQcGNIcHMakYyQ
https://mega.nz/#F!UQRR0KTK!Gog53eaG0O1FdzhYw6IWvQ


EQG iTunes Audio:

EQG Magic Movie Night (Processed): Anonfile

EQG Forgotten Friendship (Processed): Mega Anonfile

EQG TV/Other Audio:

EQG Dance Magic: Mega Anonfile

EQG Movie Magic: Mega Anonfile

EQG Mirror Magic: Mega Anonfile

EQG Better Together: Mega Anonfile

EQG Choose Your Own Ending: Mega

EQG Shorts: Mega Anonfile

EQG Mini Shorts: Mega Anonfile

Special Source

Movie: Mega Anonfile

EQG: Mega Anonfile

Datasets

Datasets not in Clipper’s Mega

For a more complete archive, check here.

Adachi Tohru (>>35454602): File House

Administrator (>>35075848): GDrive

Ai Ebihara (>>35454602): File House

Announcer (>>35072189): File House

Ayane Matsunaga (>>35454602): File House

Blaze the Cat (>>35079451): GDrive

Chie Satonaka (>>35454602): File House

https://anonfile.com/j5K0odz8na/EQG_MMN_Processed_flac
https://mega.nz/#!JEQxzKhZ!NuaP18iAyHSqt0M_6q_qUSdqC1Kt65VYSHUIOxKlUYE
https://anonfile.com/MbubWbz7n7/EQG_FF_Processed_flac
https://mega.nz/#!hMBVDCQb!rE0IsL4qPT1bohSEGhuu2f8KjZfsjNuBjpuUjNYvyeg
https://anonfile.com/q5vaW4z7nf/EQG_Dance_Magic_RAW_flac
https://mega.nz/#!NJB1mQKQ!6292pukZni9g7CkaXLjUmm9f1vsj5hAdACc4k-Eu8U8
https://anonfile.com/cdpdW6zcn9/EQG_Movie_Magic_RAW_flac
https://mega.nz/#!EVJV2IYb!Dkq_oBfygs00sk7C-0oxDGHE8qFZ2gCZIuAM0BVKa98
https://anonfile.com/l7v0W3z2nc/EQG_Mirror_Magic_RAW_flac
https://mega.nz/#F!1MY1UC6B!xe_hJDwhmq3cTDDA7KM4AQ
https://anonfile.com/M4v7W4z2n3/EQG_BT_RAW_7z
https://mega.nz/#F!KGY2AAxY!8GLsTdvRHq0g5grwbHtJBw
https://mega.nz/#F!UcZDUSpL!u6C8b6I6aRBBMbBddq_dJQ
https://anonfile.com/qaucWfz6n7/EQG_Shorts_RAW_7z
https://mega.nz/#F!ABA1TaIb!dxM-TzIcqGuvPASdHoXiQw
https://anonfile.com/idlcWcz4nd/EQG_Mini_Shorts_RAW_7z
https://mega.nz/#!VJQhgaaL!6kmdSMWR3p7gcBY-JiQmSvjMZVWN8FWZWdVzYPxgqLg
https://anonfile.com/Sbveyfk3n4/12_angry_chinese_men_yell_at_each_other_for_13_hours_7z
https://mega.nz/#!8EVS0SqA!TU7PNiR1G_YktClgFBwWaV0QqPxXDkcH5S2ZtN96aPk
https://anonfile.com/M6s4u8sfne/EGG_7z
https://docs.google.com/spreadsheets/d/1y8LvVQ7MdfMJaGWq1BrjSJxeid-Q2ERZyqvafk6hNO8/edit#gid=1386834576
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/PDsx.7z
https://desuarchive.org/mlp/thread/35074020/#35075848
https://drive.google.com/file/d/1h2kRP4wxloJ5nlUeqGwspZzCMf_6x6aJ/view?usp=sharing
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/KglG.7z
https://desuarchive.org/mlp/thread/35069772/#35072189
https://file.house/qeE8.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/iscg.7z
https://desuarchive.org/mlp/thread/35079249/#35079451
https://drive.google.com/drive/folders/17G7oxLgW8a1c9YsKb0-4oBwob9W31Bvj
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/fdZG.7z


Dan Vs. (>>35079026): GDrive

Kanji Tatsumi (>>35454602): File House

Littlepip (>>35075476): GDrive GDrive

Margaret (>>35454602): File House

Miss Kashiwagi (>>35454602): File House

Mister Morooka (>>35454602): File House

Nanako Dojima (>>35454602): File House

Naoto Shirogane (>>35454602): File House

Postal 2 Dude (>>35072009): Mega

Rise Kujikawa (>>35076495): GDrive File House Pastebin

Rise Kujikawa (>>35454602): File House

Ryotaro Dojima (>>35454602): File House

Soldier (>>35082707): GDrive File House File House

Taro Namatame (>>35454602): File House

Teddie (>>35454602): File House

Yosuke Hanamura (>>35454602): GDrive

Yukiko Amagi: File House

Yumi Ozawa: File House

Other

Audiobooks:

David Tennant, John de Lancie and Emily Blunt: Mega

Interviews:

Lauren Faust: Mega

Colab Scripts 02/22/20: Mega

Tools:

SRT to Audacity CAPX: Mega

Character Tagger CAPX: Mega

Open CAPX with Construct 2: Scirra

https://desuarchive.org/mlp/thread/35074020/#35079026
https://drive.google.com/file/d/1Iqgq3JUZ6RdUzvPFcNBdIhcSyLznxyAj
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/2CMJ.7z
https://desuarchive.org/mlp/thread/35074020/#35075476
https://drive.google.com/drive/folders/19RqzQlFB7wrTmigoTYHV6vLaEMsY9EPr
https://drive.google.com/drive/folders/1cr88K62HFChgANG1CEdy3DPQk6eruFdM
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/y0H7.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/2XLM.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/4r1w.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/W2C5.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/rHQ6.7z
https://desuarchive.org/mlp/thread/35069772/#35072009
https://mega.nz/#!lsEylQoQ!0XPoSNNWK4l9l0TSrbvCpMeairf9MIuRkruQPm4fdSc
https://desuarchive.org/mlp/thread/35074020/#35076495
https://drive.google.com/file/d/1vFdKAJawoe3bygZXB2KFG2EKhJtA_OKh/view?usp=sharing
https://file.house/bTZ2.txt
https://pastebin.com/SEp8tN8P
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/Te3P.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/T5Nb.7z
https://desuarchive.org/mlp/thread/35079249/#35082707
https://drive.google.com/file/d/1aESxQvbdY99CCvsSMtd_CjPPxuHUpGl-/view
https://file.house/vjWu.txt
https://file.house/woYn.txt
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/Sxzu.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://file.house/FTym.7z
https://desuarchive.org/mlp/thread/35437062/#35454602
https://drive.google.com/file/d/1eQAnaoDBGQZldPVk-nzgYzRbcPSmnpv6/view?usp=sharing
https://file.house/_hZD.7z
https://file.house/hGEU.7z
https://mega.nz/#!XJ9HWATB!bOG5ETjPMcxN2nfF0wPjK-B8-JrMM7gXfsacLsz76hU
https://mega.nz/#!LE8jWa4Q!xk5ex6kEcJ4W6u1bKfdSNEsEMMVYutQYySLWwJvR3UI
https://mega.nz/#F!jrQAVCyb!PxPKh58TQzzM3lOdB18Clw
https://mega.nz/#!AUVwnKZY!mKIjec90OtSg3ExCO9lZ09Kh7iKM9VUgpw5VF41VT6Y
https://mega.nz/#!UEMWTI6C!GZ-RJNH3iy-dtBrAW2CxOpQHQQuF8HoW236yBrSdWUs
https://www.scirra.com/construct2


Clipper’s Mega Snapshots
08-01-20: Mega

05-19-20: Mega

03-09-20: Mega

01-09-20: Mega

12-21-19: Mega

12-04-19: Mega

11-15-19: Mega

10-03-19: Mega

09-16-19: Mega

07-31-19: Mega

07-12-19: Mega

Synthbot’s Torrent Resources:

Clipper’s Clips:

Latest backup: Google Drive

Master File 2.0 (old): Torrent

Master File 2.x (old): Torrent

Old Torrents: Torrent

TKSynthesizer and models:

magnet:?xt=urn:btih:ef33561c15c55abf8795f11785e8a6a6d54704b5&dn=TKSynthetizer

(Source: >>35367799)

https://mega.nz/file/h2gx3ZLC#HsNHqDbdwVMJUSh8M6eqrU-Yhv7rnqd08JlcWWaFoXA
https://mega.nz/file/bOplQQoR#SN-ckzP58oGeQndsTyvrvX-TNItEeER2UhZr8924qy0
https://mega.nz/#!KQNn1CjD!T3Je-fFUlQWbaqvp3BGYtlHKXjTJKcbYFpKtWf71W3s
https://mega.nz/#!DeRSDSIa!Q_M0VBl9TvQ5td6ruLDzHOSIkvS36rhqQh3P5mhRdFQ
https://mega.nz/#!wh1yUQxK!rcBRtVuxRdeZLjp2uaaR47nbG08yVezNMPLTtyDdfsY
https://mega.nz/#!OC4QFSpK!15PMSiJ_GlvAFb3SGyVlqBC7dD80o6ZMCLqYqicGQ2M
https://mega.nz/#!ZcBzXCqT!VuBM4l8IbRMhcftlEmMp-91IvVs5cfWjxWsrz5QRKVM
https://mega.nz/#!2KpwGCJJ!zhItWgEEuzlFVZMIV9T2aPod-cF0iTqvQt3N69q2wtQ
https://mega.nz/#!JMoUFSoT!sNStCQrWeWCHkqz_LDr1Q9cgyWtWD0ElTDQ-VF-3PcA
https://mega.nz/#!vW5UlCYL!4KG94YnFSli-1qdzhCepn8zB-TFF7UNAO-a7cNTFc_w
https://mega.nz/#!vahilAxK!6lDeRfcH2e4pLuLed69m44jJCtBmEkcavDeLekx00k0
https://drive.google.com/drive/folders/1MuM9Nb_LwnVxInIPFNvzD_hv3zOZhpwx?usp=sharing
https://drive.google.com/open?id=1YrLsxjJT1xEz58mv-8rqq3OzgIANw8h0
https://drive.google.com/open?id=1z05R2r9MiQfHFd7TFi5Reb_ajC6fd9Qz
https://pastebin.com/0LGEGipE


Changelog
-02/20/21: Added AI Image Generation section
-10/03/20: Added What Can I do with the AI? section
-08/06/20: Added Synthbot.ai section
-08/06/20: Major reorganization of doc
-07/25/20: Added Open Unmix section
-07/21/20: Added OP Template section
-07/21/20: Moved Audio Samples to separate doc
-07/15/20: Added Developing Animation AI section
-07/13/20: Added Making NGroks sing section
-07/07/20: Updated How to Contribute section and general reorganization
-06/26/20: Added Inference Server (Synthesis) section
-06/22/20: Added Collected YouTube Tutorials section
-06/14/20: Moved Tools to before Resources
-06/14/20: Created new How to Contribute section
-06/14/20: Renamed old How to Contribute section to Creating Audio Dataset
-05/22/20: Updated Using TKinterAnon’s GUI section
-05/21/20: Added RTX Voice section
-05/18/20: Added Automatic Clipping and Transcribing section
-03/14/20: Big overhaul of the AI section
-02/22/20: Added Making the most of the AI section
-02/22/20: Added 48KHz instructions
-02/07/20: Added page breaks
-02/07/20: Added Using the Character Tagger section
-01/29/20: Added WiP Scripts section
-01/07/20: Added TacoTron2 Models section
-01/05/20: Added dataset processing scripts to tools
-12/29/19: Added AI Section
-12/27/19: Added links to original art posts
-12/15/19: Resource Section cleaning
-12/10/19: Added Audio Samples section
-12/05/19: Filled in Cleaning up Audio section
-12/04/19: Added video links to Cleaning Up Audio
-12/04/19: Added Pony Sorter to the tools list
- 12/04/19: Added sorting audio section
- 12/04/19: Added Open Unmix Mega to resources
- 11/16/19: Added Clipper’s Mega Snapshots
- 10/20/19: Added link to phonetics guide
- 10/19/19: Reorganized resources
- 10/19/19: New maintainer



- 05/16/19: Updated clipping instructions
- 05/16/19: Updated video demonstration link in clipping instructions
- 05/16/19: Replaced file naming conventions with updated image from thread
- 05/16/19: Updated link to Anon's Transcript Generator in Tools
- 04/27/19: Added new series of video tutorials to Clipping Audio
- 04/27/19: Added Anon’s transcript generator to Tools
- 04/20/19: Implemented various suggested changes to clean up the guide somewhat
- 04/18/19: Added Anon’s narrated video demo to Clipping Audio
- 04/16/19: Added new tracker to S1-S8 dialog torrent file, replaced old link
- 04/15/19: Added links to contribution spreadsheet
- 04/15/19: Added Anon’s video demo to Clipping Audio
- 04/15/19: Added list of episodes being worked on/complete to How to Contribute
- 04/14/19: Added logo Photoshop file to resources
- 04/14/19: Added officially endorsed file naming scheme
- 04/14/19: Added alternate subtitle source to resources
- 04/12/19: Added clarification about what counts as background noise for marking clips
- 04/12/19: Added Audio Anon’s super special lossless movie source to Resources
- 04/12/19: Added Anon’s PowerShell script for adding timestamps to Audacity labels
- 04/12/19: Added ffmpeg-based dialog extractor script to Tools
- 04/12/19: Added changelog section
- 04/12/19: Added tip to audio cleanup section for quickly removing noise in RX
- 04/12/19: Clarified how clip beginnings and ends should be decided, and how long clips

should be
- 04/12/19: Added tip for easily marking files as noisy, in the case that the majority are



Anon’s To Do List:
This is Anon’s (the doc maintainer’s) current to do list for the doc.

Create persona nerd clipping tool section. (>>35309895 and >>35312835) (github) (file house)
Delta Vox section.
Update “Our Plan” section
Update “Current Goals” section
Update “Submitting Content” section
Talk to /mlp/ section?
Move changes from WiP doc into main doc when ready
Do a large run of the DeepdanBooru notebook once I fix my Tensorflow install
Write up proper tutorials for TalkNet, DeltaVox and others

https://github.com/Iamgoofball/tacotron-transcription-tool
https://file.house/muth.7z
https://docs.google.com/document/d/1DydIFRGW-vyjvQFIJMKvQvSs2o_UO_apO0-yBZ4181E/edit


OP Template
Old version:

Last update: 9/25/20

Title: Pony Preservation Project (Thread ##)

OP Image: Smutty Horse

Text:

TwAIlight welcomes you to the Pony Voice Preservation Project!
https://clyp.it/tm03e5en

This project is the first part of the "Pony Preservation Project" dealing with the voice.
It's dedicated to saving our beloved pony's voices by creating a neural network based Text To
Speech for our favorite ponies.
Videos such as https://youtu.be/GuJKTodX1FA. or https://youtu.be/DWK_iYBl8cA have proven
that we now have the technology to generate convincing voices using machine learning
algorithms "trained" on nothing but clean audio clips.
With roughly 10 seasons (9 seasons and 5 movies) worth of voice lines available, we have more
than enough material to apply this tech for our deviant needs.

Any anon is free to join, and many are already contributing. Just read the guide to learn how you
can help bring on the wAIfu revolution. Whatever your technical level, you can help.
Document:
https://docs.google.com/document/d/1xe1Clvdg6EFFDtIkkFwT-NPLRDPvkV4G675SUKjxVRU

We now have a working TwAIlight that any Anon can play with:
https://fifteen.ai/
https://derpy.me/vCzm2 (48KHz Training)
https://derpy.me/hdJQF (48KHz Synthesis)
https://derpy.me/NR7Xi (Ngrok Synthesis)
https://derpy.me/YTJ94 (Guide)

>Active Tasks
Researching alternative vocoders
Anon transcribing books and comics
Making AI creations (In thread)
Cookie is working on controllable speech
Research into animation AI

https://u.smutty.horse/lwcnwperdle.png


>Latest Developments
AI singing
Master file 2 contains BGM and SFX
Groundwork for video generation
15's site is back up
More datasets
15 looking into multispeaker models
Delta released new local synthesis tool (no gpu required)

>Voice samples
https://derpy.me/fHs3K
https://derpy.me/O1xdh

>Clipper Anon's Master File 2.0:
https://mega.nz/#F!L952DI4Q!nibaVrvxbwgCgXMlPHVnVw
https://mega.nz/folder/0UhSmYAB#WBrB-qCprQTofkAhwMp5CQ

>Synthbot's Torrent Resources
https://derpy.me/ZJNca

>Cool, where is the discord/forum/whatever unifying place for this project!?
You're looking at it.

Last Thread:
>>########

FAQs:

FAQs:
>READ THE DOC
Do it now
https://derpy.me/V7cMp

>Did you know that such and such voiced this other thing?
Yes. We are very much aware. It is best to keep to official audio only unless there is very little of
it available. If you know of a good source of audio for characters with few (or just fewer) lines,
please post it in the thread. 5.1 is generally required unless you have a source already clean of
background noise. Preferably post a sample or link. The easier you make it, the more likely it will
be done.

>What about fan-imatitions of official voices?
No.



>How do I make the voices?
Several guides are available. In depth guides on how to do training and synthesis (making the
ponies speak) are in the doc. If you don't want to use the navigation bar in the doc, the sections
are also directly linked in the OP. If you want to use the WiP 48KHz notebook, some kind Anons
have put together some image guides for you.
48KHz Training: https://derpy.me/wW2hX
48KHz Sythesis: https://derpy.me/j4MXQ

>Where are all the voice samples?
In the doc.

>Is a place I can find all the pony models?
In the doc.

>What about muh waifu?
Check the doc.

>Will you guys be doing a [insert language here] version of the AI?
Probably not, but you're welcome to. You can however get most of the way there by using
phoenetic transcriptions of other languages.

>What about [insert OC here]'s voice?
Not a priority. Again, however, you're welcome to. There are already people doing this.

>Where can I view the PPP /mlp/con panel?
YouTube: https://youtu.be/WtuKBm67YkI
CyTube chat: https://pony.tube/videos/watch/b83fbbfc-6d4e-4768-8deb-edb61ea38abb

>I have an idea!
Great. Post it in the thread and we'll discuss it.

>Do you have a Code of Conduct?
Of course: https://fifteen.ai/code

>Is this project open source? Who is in charge of this?
[spoiler]https://derpy.me/CQ3Ca[/spoiler]

Anchor post:

Please make an anchor post for updates. HERE are some images of anchors.

https://u.smutty.horse/lwcnxgbpkct.zip


Fanart

>>33734967

https://desuarchive.org/mlp/thread/33729880/#33734967


>>33746248
Test Run Audio Demos: https://files.catbox.moe/91f1w1.zip

https://desuarchive.org/mlp/thread/33745916/#33746248
https://files.catbox.moe/91f1w1.zip


>>33794315
https://clyp.it/mmxgq1yx

https://desuarchive.org/mlp/thread/33779583/#33794315
https://clyp.it/mmxgq1yx




>>33883735

https://desuarchive.org/mlp/thread/33854142/#33883735


>>34006948

https://desuarchive.org/mlp/thread/33963949/#34006948


>>34009788

https://desuarchive.org/mlp/thread/33963949/#34009788


>>34012310

https://desuarchive.org/mlp/thread/33963949/#34012310


>>34482875

https://desuarchive.org/mlp/thread/34427076/#34482875


>>34611692

https://desuarchive.org/mlp/thread/34611670/#34611692


>>34722764

>>34726543

https://desuarchive.org/mlp/thread/34710125/#34722764
https://desuarchive.org/mlp/thread/34710125/#34726543


>>34749846

https://desuarchive.org/mlp/thread/34748129/#34749846






>>34773088

>>34778376

https://desuarchive.org/mlp/thread/34767284/#34773088
https://desuarchive.org/mlp/thread/34778298/#34778376




>>34930879

https://desuarchive.org/mlp/thread/34915676/#34930879


>>34931416

https://desuarchive.org/mlp/thread/34915676/#34931416


>>35059235

https://desuarchive.org/mlp/thread/35058606/#35059235


>>35067051

>>35839777

https://desuarchive.org/mlp/thread/35066989/#35067051
https://desuarchive.org/mlp/thread/35811011/#35839777





